VIPA System 3005

SPEED7 - CPU SC | 312-5BE13 | Manual
HB140E_CPU-SC | RE_312-5BE13 | Rev. 12/12
March 2012

ViPA

art of automation




Copyright © VIPA GmbH. All Rights Reserved.

This document contains proprietary information of VIPA and is not to be disclosed or used except in accordance with applicable
agreements.

This material is protected by the copyright laws. It may not be reproduced, distributed, or altered in any fashion by any entity (either
internal or external to VIPA), except in accordance with applicable agreements, contracts or licensing, without the express written
consent of VIPA and the business management owner of the material.

For permission to reproduce or distribute, please contact:

VIPA, Gesellschaft fur Visualisierung und Prozessautomatisierung mbH
Ohmstralie 4, D-91074 Herzogenaurach, Germany

Tel.: +49 (91 32) 744 -0

Fax.: +49 9132 744 1864

EMail: info@vipa.de

http://www.vipa.de

Note

Every effort has been made to ensure that the information contained in this document was complete and accurate at the time of
publishing. Nevertheless, the authors retain the right to modify the information. This customer document describes all the hardware
units and functions known at the present time. Descriptions may be included for units which are not present at the customer site. The
exact scope of delivery is described in the respective purchase contract.

CE Conformity

Hereby, VIPA GmbH declares that the products and systems are in compliance with the essential requirements and other relevant
provisions of the following directives:

. 2004/108/EC Electromagnetic Compatibility Directive
. 2006/95/EC Low Voltage Directive

Conformity is indicated by the CE marking affixed to the product.
Conformity Information

For more information regarding CE marking and Declaration of Conformity (DoC), please contact your local VIPA customer service
organization.

Trademarks

VIPA, SLIO, System 100V, System 200V, System 300V, System 300S, System 400V, System 500S and Commander Compact are
registered trademarks of VIPA Gesellschaft fir Visualisierung und Prozessautomatisierung mbH.

SPEEDY is a registered trademark of profichip GmbH.

SIMATIC, STEP, SINEC, S7-300 and S7-400 are registered trademarks of Siemens AG.

Microsoft und Windows are registered trademarks of Microsoft Inc., USA.

Portable Document Format (PDF) and Postscript are registered trademarks of Adobe Systems, Inc.

All other trademarks, logos and service or product marks specified herein are owned by their respective companies.

Information product support

Contact your local VIPA Customer Service Organization representative if you wish to report errors or questions regarding the contents
of this document. If you are unable to locate a customer service center, contact VIPA as follows:

VIPA GmbH, OhmstralRe 4, 91074 Herzogenaurach, Germany

Telefax:+49 9132 744 1204
EMail: documentation@yvipa.de

Technical support

Contact your local VIPA Customer Service Organization representative if you encounter problems with the product or have questions
regarding the product. If you are unable to locate a customer service center, contact VIPA as follows:

VIPA GmbH, Ohmstral3e 4, 91074 Herzogenaurach, Germany

Telephone: +49 9132 744 1150 (Hotline)
EMail: support@vipa.de



Manual VIPA System 300S SPEED7 Contents

Contents

About thisS manual .........coooo e 1
Safety iINfOrmMation ... 2
Chapter 1 BaSICS wuuiiiiiii i 1-1
Safety Information for USers.............uuviiiiiiiiiiiieeeeeee e 1-2
Operating structure of @ CPU ..o 1-3
(O U Y = = 1 R 1-6
Chapter 2 Assembly and installation guidelines..........cccccccceeee.. 2-1
Installation diMeNSIONS .......cooi i 2-2
ASSEMDIY ...t e e e aaaaa 2-3
CablING e 2-5
Installation guIdelines ..........cooi i 2-7
Chapter 3 Hardware descCription .....ccccoooeeeviviiieiiiiicie e, 3-1
PrOPEItIES... .o 3-2
SITUCIUNE . e 3-3
In-/Output range CPU 312-5BE13.......ccooiiiiiiiiieeeee e, 3-7
TechniCal Data ......ccooeeeeeeee e 3-9
Chapter 4  Deployment CPU 312-5BE13..........cceiiiiiiiiiiieiiiiiennnn 4-1
ASSEMDIY. ..o 4-2
Start-up behavior..............iiii i, 4-2
AAIrESSING ettt 4-3
Address assignMEeNt...... ... 4-5
Hardware configuration - CPU............cooiiiiiiiiiiiiee e 4-6
Hardware configuration - /O modules.............ccoooviiiiiiiiiiii e, 4-7
Hardware configuration - Ethernet PG/OP channel.............................. 4-8
CPU parameterization ..............uceiiiiiiiiiiiicce e 4-10
Project transfer....... ... e 4-14
Access to the internal web page........cccoooveiiiiiiiiii 4-17
Operating MOUES. .....cooiiiiiiiiiie e 4-18
OVErall FESEL ... 4-21
Firmware update ..........oooooiiiiiii e 4-23
FaCtory r€Set.. ..o 4-27
Slot for storage Media ..........oooiiiiiiiiiiii e 4-28
Memory extension with MCC ..., 4-29
Extended know-how protection.............cccooooeiiiiiiiiiii e 4-30
MMC-Cmd - Auto COMMANAS ........ccoiiiiiii e 4-32
VIPA specific diagnostic entries ... 4-34
Using test functions for control and monitoring of variables................ 4-39

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12 i



Contents Manual VIPA System 300S SPEED7
Chapter 5  Deployment I/O periphery........ccccccvvivvieiiieniiiiiiiiiiniiiennns 5-1
L@ = = 5-2
In-/Output range CPU 312-5BE13........cooiviiiiiiieercee e, 5-3
Address assSigNMENT..........ooviiiiiiiiiiiiiiiiieiieeee ettt 5-5
Digital Part........cooooiie e ———————— 5-6
Digital part - Parameterization ....................uueiiiiiiiiiiiiiiiiiiiiee 5-8
Counter - Fast introduction ... 5-9
Counter - CONtrolling ........cooiuueiiiiiee e 5-14
Counter - FUNCLONS.......oooiiiiiiieeee s 5-18
Counter - Additional funNCtions ............covviiiiiiii s 5-24
Counter - Diagnostic and interrupt............ccooviiiiei e, 5-31
Chapter 6  Deployment PtP communication .........ccccoeeeeeeviriiiinnnnnnn. 6-1
Fast introduction...........ooooii oo 6-2
Principals of the data transfer.............ccccoiiiiiiiiiiie 6-3
Deployment RS485 interface............coovvviiiiiiiiiiiiiieeceee e 6-4
Parameterization ...........coooo i 6-5
COMMUNICALION ... e 6-8
Protocols and proCcedures ...........ooooiiiiiiiiiiiie e 6-14
Modbus - FUNCHION COAES ......ccoeiiiiiieiiieeeee e 6-18
Modbus - Example communication..............coooviriiiiiiiiciiiiee e 6-22
Chapter 7 WINPLCT ... 7-1
System presentation...........oo i 7-2
10T} 2= 1= o o 7-3
Example project engineering ............oooooiiiiiiiiiiiiii e 7-4

i HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12



Manual VIPA System 300S SPEED7 About this manual

About this manual

Overview

This manual describes the SPEED7 CPU 312-5BE13 from the System
300S. Here you may find every information for commissioning and
operation.

Chapter 1: Principles

This Basics contain hints for the usage and information about the project
engineering of a SPEED7 system from VIPA. General information about
the System 300S like dimensions and environment conditions will also be
found.

Chapter 2: Assembly and installation guidelines

In this chapter you will find all information, required for the installation and
the cabling of a process control with the components of the System 300
and the CPU 312-5BE13.

Chapter 3: Hardware description
Here the hardware components of the CPU 312-5BE13 are described.
The technical data may be found at the end of the chapter.

Chapter 4: Deployment CPU 312-5BE13

This chapter describes the deployment of the CPU 312-5BE13 with
SPEED?7 technology in the System 300. The description refers directly to
the CPU and to the employment in connection with peripheral modules that
are mounted on a profile rail together with the CPU at standard bus.

Chapter 5: Deployment 1/O periphery

This chapter contains all information necessary for the deployment of the
in-/output periphery of the CPU 312-5BE13. It describes functionality,
project engineering and diagnostic of the analog and digital part.

Chapter 6: Deployment PtP communication

Content of this chapter is the deployment of the RS485 slot for serial PtP
communication.

Here you'll find all information about the protocols and project engineering
of the interface, which are necessary for the serial communication using
the RS485 interface.

Chapter 7: WinPLC7

In this chapter the programming and simulation software WinPLC7 from
VIPA is presented. WIinPLC7 is suited for every with Siemens STEP®7
programmable PLC.

Besides the system presentation and installation here the basics for using
the software is explained with a sample project.

More information concerning the usage of WinPLC7 may be found in the
online help respectively in the online documentation of WinPLC?7.

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12 1



About this manual

Manual VIPA System 300S SPEED7

Objective and
contents

Target audience

Structure of the
manual

The manual describes the SPEED7 CPU 312-5BE13 from VIPA. It contains
a description of the construction, project implementation and usage.

This manual is part of the documentation package with order number
HB140E_CPU-SC and relevant for:

Product Order number as of state:
CPU-HW CPU-FW
CPU 312SC VIPA 312-5BE13 01 V354

The manual is targeted at users who have a background in automation
technology.

The manual consists of chapters. Every chapter provides a self-contained
description of a specific topic.

Guide to the The following guides are available in the manual:
document « an overall table of contents at the beginning of the manual
* an overview of the topics for every chapter
Availability The manual is available in:
» printed form, on paper
* in electronic form as PDF-file (Adobe Acrobat Reader)
Icons Important passages in the text are highlighted by following icons and
Headings headings:
Danger!
Immediate or likely danger.
Personal injury is possible.
Attention!
Damages to property is likely if these warnings are not heeded.
Note!
Supplementary information and useful tips.
2 HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12
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Safety information

Applications The SPEED7 CPU is constructed and produced for:

conforming with .
specifications .

all VIPA System 300S components
communication and process control
general control and automation applications
industrial applications

operation within the environmental conditions specified in the technical
data

installation into a cubicle

Danger!
This device is not certified for applications in

in explosive environments (EX-zone)

Documentation The manual must be available to all personnel in the

project design department
installation department
commissioning

operation

The following conditions must be met before using or commissioning
the components described in this manual:

Hardware modifications to the process control system should only be
carried out when the system has been disconnected from power!

Installation and hardware modifications only by properly trained
personnel.

The national rules and regulations of the respective country must be
satisfied (installation, safety, EMC ...)

Disposal National rules and regulations apply to the disposal of the unit!

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12 3



Safety information Manual VIPA System 300S SPEED7

4 HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12



Manual VIPA System 300S SPEED7 Chapter 1 Basics

Chapter 1 Basics

Overview This Basics contain hints for the usage and information about the project
engineering of a SPEED7 system from VIPA.

General information about the System 300S like dimensions and
environment conditions will also be found.

Content Topic Page
Chapter 1 BaSICS ittt 1-1

Safety Information for USers...........ooooiiiiiiiiice e, 1-2

Operating structure of @ CPU ...........ooiiiiiiiii e 1-3

CPU 312-0BE13. it 1-6
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Manual VIPA System 300S SPEED7

Safety Information for Users

Handling of
electrostatic
sensitive modules

Shipping of
modules

Measurements and
alterations on
electrostatic
sensitive modules

VIPA modules make use of highly integrated components in MOS-
Technology. These components are extremely sensitive to over-voltages
that can occur during electrostatic discharges.

The following symbol is attached to modules that can be destroyed by
electrostatic discharges.

The Symbol is located on the module, the module rack or on packing
material and it indicates the presence of electrostatic sensitive equipment.

It is possible that electrostatic sensitive equipment is destroyed by energies
and voltages that are far less than the human threshold of perception.
These voltages can occur where persons do not discharge themselves
before handling electrostatic sensitive modules and they can damage
components thereby, causing the module to become inoperable or
unusable.

Modules that have been damaged by electrostatic discharges can fail after
a temperature change, mechanical shock or changes in the electrical load.

Only the consequent implementation of protection devices and meticulous
attention to the applicable rules and regulations for handling the respective
equipment can prevent failures of electrostatic sensitive modules.

Modules must be shipped in the original packing material.

When you are conducting measurements on electrostatic sensitive
modules you should take the following precautions:

* Floating instruments must be discharged before use.
* Instruments must be grounded.

Modifying electrostatic sensitive modules you should only use soldering
irons with grounded tips.

Attention!

Personnel and instruments should be grounded when working on
electrostatic sensitive modules.

1-2
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Operating structure of a CPU

General

Cyclic processing

Timer processing

Alarm controlled
processing

Priority based
processing

The CPU contains a standard processor with internal program memory. In
combination with the integrated SPEED7 technology the unit provides a
powerful solution for process automation applications within the System
300S family.

A CPU supports the following modes of operation:

» cyclic operation

» timer processing

» alarm controlled operation
» priority based processing

Cyclic processing represents the major portion of all the processes that
are executed in the CPU. Identical sequences of operations are repeated in
a never-ending cycle.

Where a process requires control signals at constant intervals you can
initiate certain operations based upon a timer, e.g. not critical monitoring
functions at one-second intervals.

If a process signal requires a quick response you would allocate this signal
to an alarm controlled procedure. An alarm can activate a procedure in
your program.

The above processes are handled by the CPU in accordance with their
priority. Since a timer or an alarm event requires a quick reaction, the
CPU will interrupt the cyclic processing when these high-priority events
occur to react to the event. Cyclic processing will resume, once the
reaction has been processed. This means that cyclic processing has the
lowest priority.

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12 1-3
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Manual VIPA System 300S SPEED7

Applications

System routine

User application

Operands

Process image
and periphery

The program that is present in every CPU is divided as follows:
» System routine
» User application

The system routine organizes all those functions and procedures of the
CPU that are not related to a specific control application.

This consists of all the functions that are required for the processing of a
specific control application. The operating modules provide the interfaces
to the system routines.

The following series of operands is available for programming the CPU:
* Process image and periphery

* Bit memory

» Timers and counters

» Data blocks

The user application can quickly access the process image of the inputs
and outputs PAA/PAE. You may manipulate the following types of data:

 individual Bits
* Bytes

« Words

* Double words

You may also gain direct access to peripheral modules via the bus from
user application. The following types of data are available:

* Bytes
« Words
* Blocks

1-4
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Bit Memory The bit memory is an area of memory that is accessible by means of
certain operations. Bit memory is intended to store frequently used working
data.

You may access the following types of data:
* individual Bits

* Bytes

* Words

* Double words

Timers and In your program you may load cells of the timer with a value between 10ms

counters and 9990s. As soon as the user application executes a start-operation, the
value of this timer is decremented by the interval that you have specified
until it reaches zero.

You may load counter cells with an initial value (max. 999) and increment
or decrement these when required.

Data Blocks A data block contains constants or variables in the form of bytes, words or
double words. You may always access the current data block by means of
operands.

You may access the following types of data:
* individual Bits

* Bytes

* Words

* Double words

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12 1-5
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CPU 312-5BE13

Overview

Memory
management

Integrated
Ethernet-PG/OP-
channel

Operation Security

The CPU 312-5BE13 bases upon the SPEED7 technology. This supports
the CPU at programming and communication by means of co-processors
that causes a power improvement for highest needs.

The CPU is programmed in STEP"7 from Siemens. For this you may use
WinPLC7 from VIPA or the Siemens SIMATIC Manager.

Due to the SPEED7 chipset the CPU behaves like a CPU 318. Here the
instruction set of the S7-400 from Siemens is used.

The CPU with integrated Ethernet-PG/OP channel, a MPI- and RS485-slot
simplifies the integration of the CPU into an existing network or the
connection of additional peripheral equipment.

The user application is stored in the battery buffered RAM or on an
additionally pluggable MMC storage module.

The CPU has an integrated memory. Information about the capacity
(min. capacity ... max capacity) of the memory may be found at the front of
the CPU.

The memory is divided into the following 3 parts:
* Load memory 512kbyte

» Code memory (50% of the work memory)

» Data memory (50% of the work memory)

The work memory has 64kbyte. There is the possibility to extend the work
memory to its maximum printed capacity 512kbyte by means of a MCC
memory extension card.

The CPU has an Ethernet interface for PG/OP communication. After the
assignment of IP address parameters by "Assign Ethernet Address"
respectively by a "minimum project" the Ethernet PG/OP channel may
directly be addressed by means of the "PLC" functions to program and
remote control the CPU. A max. of 4 PG/OP connections is available.

You may also access the CPU with a visualization software via these
connections.

» Wiring by CageClamps at the front connector

« Core cross-section 0.08...2.5mm?

» Total isolation of the wiring at module change

» Potential separation of all modules to the backplane bus

» ESD/Burst acc. IEC 61000-4-2/IEC 61000-4-4 (up to level 3)

» Shock resistance acc. IEC 60068-2-6 / IEC 60068-2-27 (1G/12G)

1-6
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Environmental
conditions

Dimensions/
Weight

Compatibility

Integrated
power supply

Operating temperature: 0 ... +60°C

» Storage temperature: -25 ... +70°C

» Relative humidity: 5 ... 95% without condensation
» Ventilation by means of a fan is not required

» Dimensions of the basic enclosure: 2tier width: (HXWxD) in mm:
80x125x120

» Available lengths of the profile rail in mm: 160, 482, 530, 830 and 2000

Modules and CPUs of the System 300S from VIPA and Siemens may be
used at the "Standard" bus as a mixed configuration.

The project engineering takes place in WinPLC7 from VIPA or in the
hardware configurator from Siemens.

The SPEED7 CPUs from VIPA are instruction compatible to the
programming language STEP®7 from Siemens and may be programmed
via WinPLC7 from VIPA or via the Siemens SIMATIC Manager.

Here the instruction set of the S7-400 from Siemens is used.

Note!

Please do always use the CPU 312C (6ES7 312-5BE03-0ABO0 V2.6) from
Siemens of the hardware catalog to project a CPU 312-5BE13 from VIPA.

For the project engineering, a thorough knowledge of the Siemens
SIMATIC Manager and the hardware configurator from Siemens is
required!

The CPU comes with an integrated power supply. The power supply has to
be supplied with DC 24V. By means of the supply voltage, the internal
electronic is supplied as well as the backplane bus for the peripherals
modules. The power supply is protected against inverse polarity and
overcurrent.

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12 1-7
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Chapter 2 Assembly and installation guidelines

Overview In this chapter you will find all information, required for the installation and
the cabling of a process control with the components of the System 300S
and the CPU 312-5BE13.

Content Topic Page
Chapter 2 Assembly and installation guidelines..........cccccccceeee.. 2-1

Installation diMeNSIONS ... ..cooi i 2-2

ASSEMDIY ... e a e aaaaa 2-3

CabliNG . 2-5

Installation guUIdelingS .........ccooiiiiiiiice e 2-7
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Installation dimensions

Dimensions Basic  2tier width (WxHxD) in mm: 80 x 125 x 120

enclosure
Dimensions
€
£
@
€
S
&
€
£
3
Installation e 125mm

dimensions — 120mm ————————
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P—

ezl

175mm

125 mm
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Assembly

General

Profile rail

Bus connector

The single modules are directly installed on a profile rail and connected via
the backplane bus connector. Before installing the modules you have to
clip the backplane bus connector to the module from the backside.

The backplane bus connector is delivered together with the peripheral
modules.

Order number A B C
VIPA 390-1AB60 160 140 10
VIPA 390-1AE80 482 466 8.3
VIPA 390-1AF30 530 500 15
VIPA 390-1AJ30 830 800 15
VIPA 390-9BC00* 2000 Drillings only left 15

* Unit pack: 10 pieces
Measures in mm

A
N >
325 /[ 4
_O +ﬁ<
572 | g™ 10 b oo
O @%27
VA |
// | ,;!7
5 »/15
> Cle >

For the communication between the modules the System 300S uses a
backplane bus connector. Backplane bus connectors are included in the
delivering of the peripheral modules and are clipped at the module from the
backside before installing it to the profile rail.

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12 2-3
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Assembly
possibilities

waagrechter Aufbau senkrechter
Aufbau
° H l 0 0
© [e]
liegender Aufbau — @ ‘
0 g O
’: :‘

Danger!

Please regard the allowed environment temperatures:

* horizontal assembly: from 0 to 60°C
* vertical assembly: from 0 to 40°C
» lying assembly: from 0 to 40°C
Approach

» Bolt the profile rail with the background (screw size: M6),
so that you still have minimum 65mm space above and
40mm below the profile rail.

» If the background is a grounded metal or device plate,
please look for a low-impedance connection between
profile rail and background.

» Connect the profile rail with the protected earth conductor.
For this purpose there is a bolt with M6-thread.

* The minimum cross-section of the cable to the protected
earth conductor has to be 10mm?®.

» Stick the power supply to the profile rail and pull it to the
left side to the grounding bolt of the profile rail.

* Fix the power supply by screwing.
» Take a backplane bus connector and click it at the CPU
from the backside like shown in the picture.

» Stick the CPU to the profile rail right from the power supply
and pull it to the power supply.

* Click the CPU downwards and bolt it like shown.

* Repeat this procedure with the peripheral modules, by
clicking a backplane bus connector, stick the module right
from the modules you've already fixed, click it downwards
and connect it with the backplane bus connector of the last
module and bolt it.

» The power supplies must be released before installation and repair
tasks, i.e. before handling with the power supply or with the cabling you
must disconnect current/voltage (pull plug, at fixed connection switch off
the concerning fuse)!

» Installation and modifications only by properly trained personnel!

2-4

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12



Manual VIPA System 300S SPEED7 Chapter 2 Assembly and installation guidelines

Cabling

Overview

CageClamp
technology (green)

The CPUs are exclusively delivered with CageClamp contacts. The
connection of the 1/0 periphery happens by a 40pole front connector.

Danger!

 The power supplies must be released before installation and repair
tasks, i.e. before handling with the power supply or with the cabling you
must disconnect current/voltage (pull plug, at fixed connection switch off
the concerning fuse)!

* Installation and modifications only by properly trained personnel!

For the cabling of power supply of a CPU, a green plug with CageClamp
technology is deployed.

The connection clamp is realized as plug that may be clipped off carefully if
it is still cabled.

Here wires with a cross-section of 0.08mm? to 2.5mm?® may be connected.
You can use flexible wires without end case as well as stiff wires.

[11 Test point for 2mm test tip
[2] Locking (orange) for screwdriver
[3] Round opening for wires

The picture on the left side shows the cabling step by step from top view.

» For cabling you push the locking vertical to the inside with a suiting
screwdriver and hold the screwdriver in this position.

¢ Insert the de-isolated wire into the round opening. You may use wires
with a cross-section from 0.08mm? to 2.5mm?>.

» By removing the screwdriver the wire is connected safely with the plug
connector via a spring.

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12 2-5
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Front connectors
of the in-/output
periphery

In the following the cabling of the front connector is shown:

» Open the front flap of the in-/output periphery of the CPU.
» Bring the front connector in cabling position.

» For this you plug the front connector on the module until it locks. In this
position the front connector juts out of the module and has no contact
yet.

» De-isolate your wires. If needed, use core end cases.

» If you want to lead out your cables from the bottom of the module, start
with the cabling from bottom to top, res. from top to bottom, if the cables
should be led out at the top.

» Bolt also the connection screws of not cabled screw clamps.

04 ..

» Fix the cable binder for the cable bundle.

» Bolt the fixing screw of the front connector. Now the front connector is
electrically connected with your module.

0.4 ...0.7Nm

» Close the front flap.

» Fill out the labeling strip to mark the single channels and push the strip
into the front flap.

2-6
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Installation guidelines

General

What means
EMC?

Possible
interference
causes

The installation guidelines contain information about the interference free
deployment of System 300S systems. There is the description of the ways,
interference may occur in your control, how you can make sure the
electromagnetic digestibility (EMC), and how you manage the isolation.

Electromagnetic digestibility (EMC) means the ability of an electrical
device, to function error free in an electromagnetic environment without
being interferenced res. without interferencing the environment.

All System 300S components are developed for the deployment in hard
industrial environments and fulfill high demands on the EMC. Nevertheless
you should project an EMC planning before installing the components and
take conceivable interference causes into account.

Electromagnetic interferences may interfere your control via different ways:
* Fields

» 1/O signal conductors

* Bus system

e Current supply

» Protected earth conductor

Depending on the spreading medium (lead bound or lead free) and the
distance to the interference cause, interferences to your control occur by
means of different coupling mechanisms.

One differs:

» galvanic coupling

» capacitive coupling
* inductive coupling
* radiant coupling

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12 2-7
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Basic rules for
EMC

In the most times it is enough to take care of some elementary rules to
guarantee the EMC. Please regard the following basic rules when installing
your PLC.

Take care of a correct area-wide grounding of the inactive metal parts
when installing your components.

- Install a central connection between the ground and the protected
earth conductor system.

- Connect all inactive metal extensive and impedance-low.

- Please try not to use aluminum parts. Aluminum is easily oxidizing
and is therefore less suitable for grounding.

When cabling, take care of the correct line routing.

- Organize your cabling in line groups (high voltage, current supply,
signal and data lines).

- Always lay your high voltage lines and signal res. data lines in
separate channels or bundles.

- Route the signal and data lines as near as possible beside ground
areas (e.g. suspension bars, metal rails, tin cabinet).

Proof the correct fixing of the lead isolation.
- Data lines must be laid isolated.

Analog lines must be laid isolated. When transmitting signals with
small amplitudes the one sided laying of the isolation may be
favorable.

Lay the line isolation extensively on an isolation/protected earth con-
ductor rail directly after the cabinet entry and fix the isolation with
cable clamps.

- Make sure that the isolation/protected earth conductor rail is
connected impedance-low with the cabinet.

- Use metallic or metalized plug cases for isolated data lines.
In special use cases you should appoint special EMC actions.

- Wire all inductivities with erase links.

- Please consider luminescent lamps can influence signal lines.

Create a homogeneous reference potential and ground all electrical
operating supplies when possible.

- Please take care for the targeted employment of the grounding
actions. The grounding of the PLC is a protection and functionality
activity.

- Connect installation parts and cabinets with the System 300S in star
topology with the isolation/protected earth conductor system. So you
avoid ground loops.

- If potential differences between installation parts and cabinets occur,
lay sufficiently dimensioned potential compensation lines.

2-8
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Isolation of
conductors

Electrical, magnetically and electromagnetic interference fields are
weakened by means of an isolation, one talks of absorption.

Via the isolation rail, that is connected conductive with the rack,
interference currents are shunt via cable isolation to the ground. Hereby
you have to make sure, that the connection to the protected earth conduc-
tor is impedance-low, because otherwise the interference currents may
appear as interference cause.

When isolating cables you have to regard the following:
» If possible, use only cables with isolation tangle.
» The hiding power of the isolation should be higher than 80%.

* Normally you should always lay the isolation of cables on both sides.
Only by means of the both-sided connection of the isolation you achieve
high quality interference suppression in the higher frequency area.

Only as exception you may also lay the isolation one-sided. Then you
only achieve the absorption of the lower frequencies. A one-sided
isolation connection may be convenient, if:

- the conduction of a potential compensating line is not possible
- analog signals (some mV res. pyA) are transferred
- foil isolations (static isolations) are used.

* With data lines always use metallic or metalized plugs for serial
couplings. Fix the isolation of the data line at the plug rack. Do not lay
the isolation on the PIN 1 of the plug bar!

* At stationary operation it is convenient to strip the insulated cable
interruption free and lay it on the isolation/protected earth conductor line.

» To fix the isolation tangles use cable clamps out of metal. The clamps
must clasp the isolation extensively and have well contact.

» Lay the isolation on an isolation rail directly after the entry of the cable in
the cabinet. Lead the isolation further on to the System 300S module
and don't lay it on there again!

Please regard at installation!

At potential differences between the grounding points, there may be a
compensation current via the isolation connected at both sides.

Remedy: Potential compensation line.

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12 2-9
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Chapter 3 Hardware description

Overview Here the hardware components of the CPU 312-5BE13 are described.
The technical data are at the end of the chapter.
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Properties

CPU 312SC
312-5BE13

Order data

SPEED7 technology integrated

Instruction set compatible to STEP®7 from Siemens with access to the
peripheral modules of the System 300V for the standard bus

Integrated DC24V power supply unit

64kbyte work memory integrated (32kbyte code, 32kbyte data)
Memory expandable to max. 512kbyte (256kbyte code, 256kbyte data)
Load memory 512kByte

MCC slot for external memory cards and memory extension
Status-LEDs for operating state and diagnosis

Real-time clock battery buffered

Ethernet PG/OP interface integrated

MPI interface

RS485 interface for PtP communication

Digital I/0Os: DI 16xDC24V / DO 8xDC 24V, 0.5A
2 counter (10kHz)
512 timer

512 counter
8192 bit memory

UlPP@  CPU312SC|DI16x DOBXDC,

RUN
B
MRES

VIPA 312-5BE13 A
64KByte ... 512KByte —J‘_

&

PUR DC24V 24V 0,5A

1Ll
RN E

RUN

STOP

SF

FRCE

Mee = mcc
A

S

o

| Y O =

TN o®wiv=

No o hwih o o

| |
NINETH

S

Type Order number | Description

CPU 312SC | VIPA 312-5BE13 | MPI interface, card slot, Real-time clock, Ethernet interface for

PG/OP, PtP via RS485,
DI 16xDC24V / DO 8xDC 24V, 0.5A, 2 counter
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Chapter 3 Hardware description

Structure
CPU 312SC
312-5BE13
Ule’iWR CPU3125C) Dty ggg;vim}o [1] LEDs of the CPU part
— A [2] MCC slot
sTop 00 [3] LEDs of the I/O part
1 - L i L [4] Operating mode switch CPU
2 mee = e 0l 4 i
" L5 The following components
S L] 61|
3 a = are under the front flap
4 7 STOP m ‘F i
I MRES DI DO
veAszEELD [5]  Slot for DC 24V power supply
ez]KByre _-51|2KByte S [6] Ethernet interface
o[ T ol
5 Lol for PG/OP channel
oM nEVEE .
] ” Ej - [7]  PtP interface
7 o o nEn [8] MPI interface
4
8 s
6L
x2 O x3 O =7y
MPI PtP Ll L
o]
Interfaces X ! e X A 2L
_ 8 ;\[;C24V — 2 ] 22 D
] .
@ n.c. i
@ M24V 5 DO 254['7 C——l
® RxD/TXD-P (line B) 26 /
@ R;s X ine 6 ] .
(5 M5V 4‘ li
® P5V T 2
@ P24V 8 2
(® RxD/TxD-N (line A) I % '7
® nc. 9 30
2M
@ n.c. DI — (i)
@ M24Vv
(3 RxD/TxD-P (line B) 12 -
@ RTS e —
® Msv 13— |
® P5V
@ P2av “ |
RXD/TxD-N (line A)
® nec. 15 l—
% -
(® Transmit + 17 -
(2 Transmit - e —
% nR‘e((::‘eive+ 18 —
% nR‘e((;:‘eive— B __—
e o 1w
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Power supply
X1

MPI interface
X2

PtP interface
X3

Ethernet PG/OP
channel
X5

The CPU has an integrated power supply. The power supply has to be
provided with DC 24V. For this serves the DC 24V slot, that is underneath
the flap.

Via the power supply not only the internal electronic is provided with
voltage, but by means of the backplane bus also the connected modules.
The power supply is protected against polarity inversion and overcurrent.
The internal electronic is galvanically connected with the supply voltage.

Please regard that the integrated power supply may provide the backplane
bus with a sum of max. 5A depending on the CPU.

9pin SubD jack:
The MPI interface serves for the connection between programming unit
and CPU. By means of this the project engineering and programming

happens. In addition MPI serves for communication between several CPUs
or between HMIs and CPU.

Standard setting is MPI Address 2.

9pin SubD jack:

The CPU has a RS 485 interface. The interface is fix set to PtP
communication.

Using the PtP functionality the RS485 interface is allowed to connect via
serial point-to-point connection to different source res. target systems.
Here the following protocols are supported:

ASCII, STX/ETX, 3964R, USS and Modbus master (ASCII, RTU).

The PtP communication is configured during run-time by means of the SFC
216 (SER_CFG). The communication happens by means of the SFC 217
(SER_SND) and SFC 218 (SER_RCV).

9pin SubD jack:

The RJ45 jack serves the interface to the Ethernet PG/OP channel. This
interface allows you to program res. remote control your CPU, to access
the internal website or to connect a visualization via up to 4 PG/OP
connections.

For online access to the CPU via Ethernet PG/OP channel valid IP address
parameters have to be assigned to this. More may be found at chapter
"Deployment CPU 31..." at "Initialization Ethernet PG/OP channel".

3-4
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Memory
management

Operating mode
switch

RUN
(B)swr
MRES

Storage
media slot

The CPU has an integrated memory. Information about the capacity
(min. capacity ... max capacity) of the memory may be found at the front of
the CPU.

The memory is divided into the following 3 parts:
* Load memory 512kbyte

» Code memory (50% of the work memory)

» Data memory (50% of the work memory)

The work memory has 64kbyte. There is the possibility to extend the work
memory to its maximum printed capacity 512kbyte by means of a MCC
memory extension card.

With the operating mode switch you may switch the CPU between STOP
and RUN.

During the transition from STOP to RUN the operating mode START-UP is
driven by the CPU.

Placing the switch to MRES (Memory Reset), you request an overall reset
with following load from MMC, if a project there exists.

As external storage medium for applications and firmware you may use a
MMC storage module (Multimedia card) or a MCC memory extension card.
The MCC can additionally be used as an external storage medium.

Both VIPA storage media are pre-formatted with the PC format FAT16 and
can be accessed via a card reader. An access to the storage media always
happens after an overall reset and PowerON.

After PowerON respectively an overall reset the CPU checks, if there is a
storage medium with data valid for the CPU.
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LEDs The CPU has got LEDs on its front side. In the following the usage and the
according colors of the LEDs is described.

LEDs CPU As soon as the CPU is supplied with 5V, the green PWR-LED is on.

RUN | STOP SF FRCE | MCC |Meaning
green | yellow red yellow | yellow

Boot-up after PowerON

® {:E* () ) () * Blinking with 10Hz: Firmware is loaded.
[ [ [ ) ] [ Initialization: Phase 1
® ] ® () @) Initialization: Phase 2
[ [ [ ) O @) Initialization: Phase 3
@) ® ® O @) Initialization: Phase 4
Operation
@) [ ) X X X CPU is in STOP state.
ﬁ o X X X 82%8 Elsé:rst{l;grs?”(:te, the RUN LED blinks during operating
{ O O X X CPU is in state RUN without error.
X X ° X X giZZfolsStiisS}t;sthfig :‘)aft:lr’:él\égﬁ -|nformat|on may be found in the
X X X ® X Variables are forced.
X X X X ] Access to the memory card.

Overall reset

o | I

Overall reset is requested.

X
X
X

o | xt*

* Blinking with 5Hz: Overall reset is executed.

X
X
X

Factory reset

® ] O O @) Factory reset is executed.

@) [ ]

Factory reset finished without error.

Firmware update

The alternate blinking indicates that there is new firmware on
¢ ij} %:} o the memory card.
The alternate blinking indicates that a firmware update is
© © ij} %:} e executed.
e) ) ) ) Firmware update finished without error.
0] {:E* {:}* {:E* {:}* * Blinking with 10Hz: Error during Firmware update.

on: ® off: O blinking (2Hz): ij} not relevant: X

LEDs Ethernet The green A-LED (Activity) indicates the physical connection of the
PG/OP channel Ethernet PG/OP channel to Ethernet. Irregular flashing of the A-LED
A'S indicates communication of the Ethernet PG/OP channel via Ethernet.

If the green S-LED (Speed) is on, the Ethernet PG/OP has a
communication speed of 100MBit/s otherwise with 10MBit/s.
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In-/Output range CPU 312-5BE13

Overview
CPU 312-5BE13

The CPU 312-5BE13 has the following analog and digital in- and output
ranges integrated in one casing:

» Digital Input: 16xDC 24V
» Digital Output: 8xDC 24V, 0.5A
» Technological functions: 2 Channels

Each of the digital in-/ outputs monitors its state via a LED. Via the
parameterization you may assign alarm properties to every digital input.
Additionally the digital inputs are parameterizable as counter.

X11:

1 1L+ 21 2L+

2 &Di
3 — | 23 D
4~ | %7
s ] % 1 C—
6 - DO — 2
- | %
8 — | 224['7
S 30

2M
DI —| (=

2 |
13— |
14— |
5 |
6 |
17w -
18— |
19 |

| 20 1™

Attention!

Please take care that the voltage at an output channel always is < the
supply voltage via L+.
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CPU 312-5BE13: Pin assignment and status indicator
Pin Assignment

PO Ao ©O®NO O AN

N ) a2 a A a a
O © 0o N O O b

Power supply +DC 24V

1+0.0 / Channel 0 (A)/Pulse
1+0.1 / Channel 0 (B)/Direction
1+0.2 / Channel 0 HW gate
1+0.3 / Channel 1 (A)/Pulse
1+0.4 / Channel 1 (B)/Direction
1+0.5 / Channel 1 HW gate
1+0.6

1+0.7

not connected

not connected

1+1.0

I+1.1

1+1.2

1+1.3

I1+1.4 / Channel 0 Latch

I1+1.5 / Channel 1 Latch

1+1.6

+1.7

Ground 1M DI

Connection
1 1L+

LEDs

DI16x DO8x

— 2 -

DI —

+
o

DC24v  DC24V

,—'O,SA :I\I_+2L+

o

£
1

MTNo o b wN =

Y
T

N Y I 4

~No b WON -2 O

[T T T T rrririris

9
o)
(®)

N ¥ O 9

9
o)
o

CPU 312-5BE13: Pin assignment and status indicator
Pin Assignment

21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40

Power supply +DC 24V
Q+0.0 / Channel 0 Output
Q+0.1/ Channel 1 Output
Q+0.2 / Channel 2 Output
Q+0.3

Q+0.4

Q+0.5

Q+0.6

Q+0.7

Ground 2M DO

not connected

not connected

not connected

not connected

not connected

not connected

not connected

not connected

not connected

not connected

DO —

Connection
21 2L+

(n)

LEDs

DI16x DO8x .
DC24v  DC24V,—

—0oA L

|

1L2L+4
—

No okl wido o

—_— 2L+

— 1L+

Dl:
L1+

DO:
L2+

LED (green)
Supply voltage
available for DI

LEDs (green)
[+0.0 to [+0.7
resp. 1+1.0 to
+1.7
Starting with
app. 15V the
signal "1" at
the input is
recognized
and the
according
LED

LED (green)
Supply voltage
available for
DO

LEDs (green)
Q+0.0 to
Q+0.7

on at active
output

LED (red)
Overload or
short circuit
error
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Technical Data

Order number 312-5BE13
Type CPU 312SC
SPEED-Bus -

Technical data power supply

Power supply (rated value) DC 24V
Power supply (permitted range) DC 20.4...28.8V
Reverse polarity protection v

Current consumption (no-load operation) 135 mA
Current consumption (rated value) 500 mA
Inrush current 11A
Technical data digital inputs

Number of inputs 16

Cable length, shielded 1000 m
Cable length, unshielded 600 m

Rated load voltage DC 24V
Reverse polarity protection of rated load voltage v

Current consumption from load voltage L+ (without | 70 mA

load)

Rated value DC 24V
Input voltage for signal "0" DCO0..5V
Input voltage for signal "1" DC 15...28.8V
Input voltage hysteresis -

Frequency range -

Input resistance -

Input current for signal "1" 6 mA
Connection of Two-Wire-BEROs possible v

Max. permissible BERO quiescent current 1.5 mA

Input delay of "0" to "1" 0.1/0.35 ms
Input delay of "1" to "0" 0.1/0.35ms

Number of simultaneously utilizable inputs
horizontal configuration

Number of simultaneously utilizable inputs vertical
configuration

Input characteristic curve

IEC 61131, type 1

Initial data size

2 Byte

Technical data digital outputs

Number of outputs 8

Cable length, shielded 1000 m
Cable length, unshielded 600 m

Rated load voltage DC 24V
Reverse polarity protection of rated load voltage -

Current consumption from load voltage L+ (without | 100 mA

load)

Total current per group, horizontal configuration, 3A

40°C

Total current per group, horizontal configuration, 2A

60°C

Total current per group, vertical configuration 2A

Output voltage signal "1" at min. current L+ (-0.8V)
Output voltage signal "1" at max. current -

Output current at signal "1", rated value 0.5A

Output current, permitted range to 40°C 5mAt0 0.6 A
Output current, permitted range to 60°C 5mAto 0.6 A
Output current at signal "0" max. (residual current) | 0.5 mA

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12
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Order number 312-5BE13
Output delay of "0" to "1" -
Output delay of "1" to "0" -
Minimum load current -
Lamp load 5W

Parallel switching of outputs for redundant control | possible

of a load

Parallel switching of outputs for increased power not possible
Actuation of digital input v

Switching frequency with resistive load max. 2.5 kHz
Switching frequency with inductive load max. 0.5 Hz
Switching frequency on lamp load max. 2.5 kHz
Internal limitation of inductive shut-off voltage L+ (-52V)
Short-circuit protection of output yes, electronic
Trigger level 1A

Number of operating cycle of relay outputs -
Switching capacity of contacts -
Output data size 1 Byte
Technical data analog inputs
Number of inputs -
Cable length, shielded -
Rated load voltage -
Reverse polarity protection of rated load voltage -
Current consumption from load voltage L+ (without |-
load)
Voltage inputs -
Min. input resistance (voltage range) -
Input voltage ranges -
Operational limit of voltage ranges -
Basic error limit voltage ranges with SFU -
Current inputs -
Min. input resistance (current range) -
Input current ranges -
Operational limit of current ranges -
Basic error limit current ranges with SFU -
Resistance inputs -
Resistance ranges -
Operational limit of resistor ranges -
Basic error limit -
Resistance thermometer inputs -
Resistance thermometer ranges -
Operational limit of resistance thermometer ranges | -
Basic error limit thermoresistor ranges -
Thermocouple inputs -
Thermocouple ranges -
Operational limit of thermocouple ranges -
Basic error limit thermoelement ranges -
Programmable temperature compensation -
External temperature compensation -
Internal temperature compensation -
Resolution in bit -
Measurement principle -
Basic conversion time -
Noise suppression for frequency -
Initial data size -
Technical data analog outputs
Number of outputs -
Cable length, shielded -
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Order number

312-5BE13

Rated load voltage

Reverse polarity protection of rated load voltage

Current consumption from load voltage L+ (without
load)

Voltage output short-circuit protection

Voltage outputs

Min. load resistance (voltage range)

Max. capacitive load (current range)

Output voltage ranges

Operational limit of voltage ranges

Basic error limit voltage ranges with SFU

Current outputs

Max. in load resistance (current range)

Max. inductive load (current range)

Output current ranges

Operational limit of current ranges

Basic error limit current ranges with SFU

Settling time for ohmic load

Settling time for capacitive load

Settling time for inductive load

Resolution in bit

Conversion time

Substitute value can be applied

Output data size

Technical data counters

Number of counters

Counter width

32 Bit

Maximum input frequency

10 kHz

Maximum count frequency

10 kHz

Mode incremental encoder

Mode pulse / direction

Mode pulse

Mode frequency counter

Mode period measurement

Gate input available

ANRNE

Latch input available

Reset input available

Counter output available

\ 1

Load and working memory

Load memory, integrated

512 KB

Load memory, maximum

512 KB

Work memory, integrated

64 KB

Work memory, maximal

512 KB

Memory divided in 50% program / 50% data

v

Memory card slot

MMC-Card with max. 1 GB

Hardware configuration

Racks, max.

Modules per rack, max.

Number of integrated DP master

Number of DP master via CP

Operable function modules

Operable communication modules PtP

Operable communication modules LAN

[ee] Kool o) PN [en) Foo) F

Status information, alarms, diagnostics

Status display

yes

Interrupts

yes

Process alarm

yes

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12
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Order number 312-5BE13
Diagnostic interrupt yes
Diagnostic functions no
Diagnostics information read-out possible
Supply voltage display green LED
Group error display red SF LED

Channel error display

red LED per group

Command processing times

Bit instructions, min. 0.02 us
Word instruction, min. 0.02 us
Double integer arithmetic, min. 0.02 ys
Floating-point arithmetic, min. 0.12 us
Timers/Counters and their retentive

characteristics

Number of S7 counters 512
Number of S7 times 512
Data range and retentive characteristic

Number of flags 8192 Byte
Number of data blocks 4095
Max. data blocks size 64 KB
Max. local data size per execution level 510 Byte
Blocks

Number of OBs 15
Number of FBs 2048
Number of FCs 2048
Maximum nesting depth per priority class 8
Maximum nesting depth additional within an error |4

OB

Time

Real-time clock buffered v

Clock buffered period (min.) 6W
Accuracy (max. deviation per day) 10s
Number of operating hours counter 8

Clock synchronization v
Synchronization via MPI Master/Slave
Synchronization via Ethernet (NTP) no
Address areas (1/0O)

Input I/O address area 1024 Byte
Output I/0O address area 1024 Byte
Input process image maximal 128 Byte
Output process image maximal 128 Byte
Digital inputs 272
Digital outputs 264
Digital inputs central 272
Digital outputs central 264
Integrated digital inputs 16
Integrated digital outputs 8
Analog inputs 64
Analog outputs 64
Analog inputs, central 64
Analog outputs, central 64
Integrated analog inputs 0
Integrated analog outputs 0
Communication functions

PG/OP channel v
Global data communication v
Number of GD circuits, max. 4

Size of GD packets, max. 22 Byte

3-12
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Order number 312-5BE13
S7 basic communication v

S7 basic communication, user data per job 76 Byte

S7 communication v

S7 communication as server v

S7 communication as client -

S7 communication, user data per job 160 Byte
Number of connections, max. 32
Functionality Sub-D interfaces

Type X2

Type of interface RS485
Connector Sub-D, 9-pin, female
Electrically isolated -

MPI v

MP?l (MPI/RS232) -

DP master -

DP slave -
Point-to-point interface -

Type X3

Type of interface RS485
Connector Sub-D, 9-pin, female
Electrically isolated v

MPI -

MP?l (MPI/RS232) -

DP master -

DP slave -
Point-to-point interface v

CAN -
Functionality MPI

number of connections, max. 32

PG/OP channel v

Routing -

Global data communication v

S7 basic communication v

S7 communication v

S7 communication as server v

S7 communication as client -
Transmission speed, min. 19.2 kbit/s
Transmission speed, max. 187.5 kbit/s

Functionality PROFIBUS master

PG/OP channel

Routing

S7 basic communication

S7 communication

S7 communication as server

S7 communication as client

Equidistance support

Isochronous mode

SYNC/FREEZE

Activation/deactivation of DP slaves

Direct data exchange (slave-to-slave
communication)

DPV1

Transmission speed, min.

Transmission speed, max.

Number of DP slaves, max.

Address range inputs, max.

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12
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Order number 312-5BE13
Address range outputs, max. -
User data inputs per slave, max. -
User data outputs per slave, max. -
Functionality PROFIBUS slave

PG/OP channel -
Routing -
S7 communication -
S7 communication as server -
S7 communication as client -
Direct data exchange (slave-to-slave -
communication)

DPV1 -
Transmission speed, min. -
Transmission speed, max. -
Automatic detection of transmission speed -
Transfer memory inputs, max. -
Transfer memory outputs, max. -
Address areas, max. -
User data per address area, max. -
Point-to-point communication

PtP communication v
Interface isolated v
RS232 interface -
RS422 interface -
RS485 interface v

Connector

Sub-D, 9-pin, female

Transmission speed, min.

150 bit/s

Transmission speed, max. 115.5 kbit/s
Cable length, max. 500 m
Point-to-point protocol

ASCII protocol v
STX/ETX protocol v

3964(R) protocol v

RK512 protocol -

USS master protocol v

Modbus master protocol v

Modbus slave protocol -

Special protocols -
Functionality RJ45 interfaces

Type X5

Type of interface Ethernet 10/100 MBit
Connector RJ45
Electrically isolated v

PG/OP channel v

Productive connections

Mechanical data

Dimensions (WxHxD)

80 x 125 x 120 mm

Weight

410 g

Environmental conditions

Operating temperature

0°Cto60°C

Storage temperature

-25°Cto 70 °C

Certifications

UL508 certification

in preparation
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Chapter 4

Overview

Content

Deployment CPU 312-5BE13

This chapter describes the deployment of the CPU 312-5BE13 with
SPEED?7 technology in the System 300S. The description refers directly to
the CPU and to the employment in connection with peripheral modules that
are mounted on a profile rail together with the CPU at standard bus.
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Assembly

Note!

Information about assembly and cabling may be found at chapter
"Assembly and installation guidelines”.

Start-up behavior

Turn on power
supply

Default boot
procedure, as
delivered

Boot procedure with
valid data in the
CPU

Boot procedure
with empty battery

After the power supply has been switched on, the CPU changes to the
operating mode the operating mode lever shows.

When the CPU is delivered it has been reset.
After a STOP - RUN transition the CPU switches to RUN without program.

The CPU switches to RUN with the program stored in the battery buffered
RAM.

The accumulator/battery is automatically loaded via the integrated power
supply and guarantees a buffer for max. 30 days. If this time is exceeded,
the battery may be totally discharged. This means that the battery buffered
RAM is deleted.

In this state, the CPU executes an overall reset. If a MMC is plugged,
program code and data blocks are transferred from the MMC into the work
memory of the CPU.

If no MMC is plugged, the CPU transfers permanent stored "protected"
blocks into the work memory if available.

Information about storing protected blocks in the CPU is to find in this
chapter at "Extended Know-how protection".

Depending on the position of the operating mode switch, the CPU switches
to RUN res. remains in STOP.

This event is stored in the diagnostic buffer as: "Start overall reset
automatically (unbuffered PowerON).

4-2
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Addressing

Overview

Addressing
Backplane bus
I/O devices

Max. number of
pluggable
modules

Define addresses
by hardware
configuration

To provide specific addressing of the integrated in-/output periphery and the
installed peripheral modules, certain addresses must be allocated in the
CPU.

At the start-up of the CPU, this assigns automatically peripheral addresses
for digital in-/output modules starting with 0 and ascending depending on the
slot location.

If no hardware project engineering is available, the CPU stores at the
addressing analog modules to even addresses starting with 256.

The integrated in-/output periphery is also allocated to the address area of
the CPU. More may be found at "Address assignment".

The CPU provides an I/O area (address 0 ... 8191) and a process image of
the in- and outputs (each address 0 ... 127).

The process image stores the signal states of the lower address (0 ... 127)
additionally in a separate memory area.

The process image this divided into two parts:
» process image to the inputs (PII)
» process image to the outputs (PIQ)

I/O area Process image
0 0
' — Inputs
) PII
-_ | Digital modules | 127
1?7 Analog modules 0
Outputs
) ) PIQ
8191 127

The process image is updated automatically when a cycle has been
completed.

Maximally 8 modules may be addressed by the CPU 312-5BE13. The
extension by means of extension racks is not possible.

You may access the modules with read res. write accesses to the
peripheral bytes or the process image.

To define addresses a hardware configuration may be used. For this, click
on the properties of the according module and set the wanted address.
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Automatic If you do not like to use a hardware configuration, an automatic addressing
addressing comes into force.
At the automatic address allocation DIOs occupy depending on the slot
location always 4byte and AlOs, FMs, CPs always 16byte at the bus.
Depending on the slot location the start address from where on the
according module is stored in the address range is calculated with the
following formulas:
DIOs: Start address = 4[(slot -4)
AlOs, FMs, CPs: Start address = 16I[{slot -4)+256
Slot number 4,5, ..  =——fp
4 5 6 7
-]
Start o
address O
digital: O 0 4 8 12
analog: n 256 272 288 304
Example for The following sample shows the functionality of the automatic address
automatic address allocation:
allocation
Slot number: 4 5 6 7 8
> >
2 S 3 _ Bus
OmmEmm Qmm Swm D
= =) ~ ] & X
(&) 3 % © e X
O - it o o o
(2] o < o o <
A
Pl Address Periphery area Periphery area Address PIQ
0 Input Byte Y
1 Input Byte Il T Output Byte 8
— Output Byte 9 —>
; Input B :
i ——— oupusye | 2
up to max. 127 153 Input Byte Output Byte 13 ~ up to max. 127
T. 255 255 E’T
i il
2%2 Input Byte 3?0 °

2048

8191

i
I

Input Byte Output Byte 31:35

2048

8191
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Address assignment

Input range
Sub module Default- Access Assignment
Address
DI10/DO6 124 Byte Digital Input 1+0.0 ... 1+0.7
125 Byte Digital Input 1+1.0 ... 1+1.7
Counter 768 Dint Channel 0: Count value / Frequency value
772 Dint Channel 1: Count value / Frequency value
776 Dint reserved
780 Dint reserved
Output range
Sub module Default- Access Assignment
Address
DI10/DO6 124 Byte Digital Output Q+0.0 ... Q+0.7
Counter 768 DWord reserved
772 DWord reserved
776 DWord reserved
780 DWord reserved
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Hardware configuration - CPU

Requirements

The hardware configuration of the VIPA CPU takes place at the Siemens
hardware configurator.

The hardware configurator is a part of the Siemens SIMATIC Manager. It
serves the project engineering. The modules, which may be configured
here are listed in the hardware catalog. If necessary you have to update the
hardware catalog with Options > Update Catalog.

For project engineering a thorough knowledge of the Siemens SIMATIC
manager and the Siemens hardware configurator are required!

Note!

Please consider that this SPEED7-CPU has 4 ACCUs. After an arithmetic
operation (+I, -I, *I, /I, +D, -D, *D, /D, MOD, +R, -R, *R, /R) the content of
ACCU 3 and ACCU 4 is loaded into ACCU 3 and 2.

This may cause conflicts in applications that presume an unmodified
ACCU2.

For more information may be found in the manual "VIPA Operation list
SPEEDT7" at "Differences between SPEED7 and 300V programming".

To be compatible with the Siemens SIMATIC manager the following steps
should be executed:

« Start the Siemens hardware configurator with a new project.

» Insert a profile rail from the hardware catalog.

* Place at slot 2 the following CPU from Siemens:

Proceeding
Slot | Module
1
2 CPU 312C
2.2 | DI10/DO6
2.4 | Count
3

CPU 312C (6ES7 312-5BE03-0AB0 V2.6).

4-6
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Hardware configuration - /O modules

Hardware
configuration of
the modules

Parameterization

Parameterization
during runtime

Maximum 8 modules
addressable

After the hardware configuration place the System 300 modules in the
plugged sequence starting with slot 4.

H H Slot | Module |
D) 1 Parameter DIO
[ 2 CPU
Param : .. Param : .
Param : .. Param : .
Param : .. Param : .
DI DO plo Al AOC Param : .. Param : .
cPU 3
4 DI ’
6 | DIO”
7 Al
8 AO
9
10
11

For parameterization double-click during the project engineering at the slot
overview on the module you want to parameterize In the appearing dialog
window you may set the wanted parameters.

By using the SFCs 55, 56 and 57 you may alter and transfer parameters for
wanted modules during runtime.

For this you have to store the module specific parameters in so called
"record sets".

More detailed information about the structure of the record sets is to find in
the according module description.

Maximally 8 modules may be addressed by the CPU312-5BE13. The
extension by means of extension racks is not possible.
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Hardware configuration - Ethernet PG/OP channel

Overview

Assembly and
commissioning

"Initialization" via
PLC functions

The CPU 312-5BE13 has an integrated Ethernet PG/OP channel. This
channel allows you to program and remote control your CPU.

The PG/OP channel also gives you access to the internal web page that
contains information about firmware version, connected 1/O devices, current
cycle times etc.

With the first start-up respectively after an overall reset the Ethernet PG/OP
channel does not have any IP address.

For online access to the CPU via Ethernet PG/OP channel valid IP address
parameters have to be assigned to this by means of the Siemens SIMATIC
manager. This is called "initialization".

 Install your System 300S with your CPU.

» Wire the system by connecting cables for voltage supply and signals.
» Connect the Ethernet jack of the Ethernet PG/OP channel to Ethernet
» Switch on the power supply.

- After a short boot time the CP is ready for communication.
He possibly has no IP address data and requires an initialization.

The initialization via PLC functions takes place with the following
proceeding:
» Determine the current Ethernet (MAC) address of your Ethernet PG/OP

channel. This always may be found as 1. address under the front flap of
the CPU on a sticker on the left side.

Ethernet address
Ethernet PG/OP

4-8
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Assign IP address You get valid IP address parameters from your system administrator. The
parameters assignment of the IP address data happens online in the Siemens SIMATIC
manager starting with version V 5.3 & SP3 with the following proceeding:

Start the Siemens SIMATIC manager and set via Options > Set PG/PC

interface the access path to "TCP/IP -> Network card .... ".

Open with PLC > Edit Ethernet Node the dialog window with the same
name.

To get the stations and their MAC address, use the [Browse] button or
type in the MAC Address. The Mac address may be found at the 1. label
beneath the front flap of the CPU.

Choose if necessary the known MAC address of the list of found
stations.

Either type in the IP configuration like IP address, subnet mask and
gateway. Or your station is automatically provided with IP parameters by
means of a DHCP server. Depending of the chosen option the DHCP
server is to be supplied with MAC address, equipment name or client ID.
The client ID is a numerical order of max. 63 characters. The following
characters are allowed: "hyphen”, 0-9, a-z, A-Z

Confirm with [Assign IP configuration].

Note!

Direct after the assignment the Ethernet PG/OP channel may be reached
online by these address data.

The value remains as long as it is reassigned, it is overwritten by a
hardware configuration or an factory reset is executed.

Take IP address
parameters in
project .

Open the Siemens hardware configurator und configure the Siemens
CPU 312C (6ES7 312-5BE03-0ABO0 V2.6).

Configure the modules at the standard bus.

For the Ethernet PG/OP channel you have to configure a Siemens
CP 343-1 (SIMATIC 300 \ CP 300 \ Industrial Ethernet \CP 343-1 \ 6GK7
343-1EX11 0XEOQ) always below the really plugged modules.

Open the property window via double-click on the CP 343-1EX11 and
enter for the CP at "Properties" the IP address data, which you have
assigned before.

Transfer your project.

Standard bus (serial) — Standard bus

Slot | Module
1
2 CPU

Ethernet-PG/OP

DI

DO

DIO

Al

AO
343-1EX11

DI DO DIO Al AO

o]
T
c

Ethernet PG/OP channel

2B oo (N |o o & e
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CPU parameterization

Overview

Supported
parameters

General
Short description

Order No. /
Firmware

Name

Interface
Properties

Comment

Since the CPU 312-5BE13 of VIPA is to be configured as Siemens CPU
312C in the Siemens hardware configurator, the parameters of the CPU
312-5BE13 may be set with "Object properties" during hardware
configuration.

Via a double-click on the CPU 312C the parameter window may be
accessed.

Using the registers you get access to all parameters of the CPU.

Parameter CPU
SIOt MOdU|e Param: ......... Param: .........
1 ” Param : ......... Param : .........
P D P s
2 [CPU.. - Param oo Param -
3
4
Note!

A description of the parameters of the sub module DI10/DO6 and Counter
may be found at chapter "Deployment 1/O periphery".

The CPU does not evaluate all parameters that may be set at the hardware
configuration.

The following parameters are supported at this time:

The short description of the Siemens CPU 312-5BE03 is CPU 312C.

Order number and firmware are identical to the details in the "Hardware
catalog" window.

The Name field provides a short description of the module, which you can
change to meet your requirements. If you change the description, the new
description appears in the SIMATIC Manager.

Here the address of the MPI interface stands.
Click the "Properties" button to change the properties of the MPI interface.

In this field information about the module may be entered.

4-10
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Startup

Startup when
expected/actual
configuration differ

Monitoring Time for
Ready message by
modules [100ms]

Monitoring Time for
Transfer of
parameters to
modules [100ms]

Cycle/Clock
memory

Update OB1
process image
cyclically

Scan cycle
monitoring time

Minimum scan
cycle time

Scan cycle load
from Communi-
cation

If the checkbox for "Startup when expected/actual configuration differ" is
deselected and at least one module is not located at its configured slot or if
another type of module is inserted there instead, then the CPU does not
switch to RUN mode and remains in STOP mode.

If the checkbox for "Startup when expected/actual configuration differ" is
selected, then the CPU starts even if there are modules are not located in
their configured slots of if another type of module is inserted there instead,
such as during an initial system start-up.

This operation specifies the maximum time for the ready message of every
configured module after PowerON. If the modules do not send a ready
message to the CPU by the time the monitoring time has expired, the
actual configuration becomes unequal to the preset configuration.

The maximum time for the transfer of parameters to parameterizable
modules. If not all of the modules have been assigned parameters by the
time this monitoring time has expired, the actual configuration becomes
unequal to the preset configuration.

This parameter is not relevant.

Here the scan cycle monitoring time in milliseconds may be set. If the scan
cycle time exceeds the scan cycle monitoring time, the CPU enters the
STOP mode. Possible reasons for exceeding the time are:

* Communication processes
» aseries of interrupt events
e an error in the CPU program

This parameter is not relevant.

Using this parameter you can control the duration of communication
processes, which always extend the scan cycle time so it does not exceed
a specified length.

If the cycle load from communication is set to 50%, the scan cycle time of
OB 1 can be doubled. At the same time, the scan cycle time of OB 1 is still
being influenced by asynchronous events (e.g. hardware interrupts) as well.

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12
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0OB85-Call up at I/0
Access Error

Clock Memory

Retentive Memory

Number of Memory
Bytes from MBO

Number of S7
Timers from TO

Number of S7
Counters from CO
Areas

Interrupts

Priority

Time-of-Day
interrupts
Priority

Active

Execution

Start date / Time

Process image
partition

The preset reaction of the CPU may be changed to an I/O access error that
occurs during the update of the process image by the system.

The VIPA CPU is preset such that OB 85 is not called if an I/O access error
occurs and no entry is made in the diagnostic buffer either.

Activate the check box if you want to use clock memory and enter the
number of the memory byte.

Note!
The selected memory byte cannot be used for temporary data storage.

Enter the number of retentive memory bytes from memory byte 0 onwards.

Enter the number of retentive S7 timers from TO onwards. Each S7 timer
occupies 2 bytes.

Enter the number of retentive S7 counter from CO onwards.

These parameters are not relevant.

Here the priorities are displayed, according to which the hardware interrupt
OBs are processed (hardware interrupt, time-delay interrupt, async. error
interrupts).

The priority may not be modified.

Activate the check box of the time-of-day interrupt OBs if these are to be
automatically started on complete restart.

Select how often the interrupts are to be triggered. Intervals ranging from
every minute to yearly are available. The intervals apply to the settings
made for start date and time.

Enter date and time of the first execution of the time-of-day interrupt.

This parameter is not supported.

4-12
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Cyclic interrupts

Priority

Execution

Phase offset

Process image
partition

Protection

Level of protection

Here the priorities may be specified according to which the corresponding
cyclic interrupt is processed. With priority "0" the corresponding interrupt is
deactivated.

Enter the time intervals in ms, in which the watchdog interrupt OBs should
be processed. The start time for the clock is when the operating mode
switch is moved from STOP to RUN.

Enter the delay time in ms for current execution for the watch dog interrupt.
This should be performed if several watchdog interrupts are enabled.
Phase offset allows to distribute processing time for watchdog interrupts
across the cycle.

This parameter is not supported.

Here 1 of 3 protection levels may be set to protect the CPU from
unauthorized access.

Protection level 1 (default setting):

* No password adjustable, no restrictions
Protection level 2 with password:

» Authorized users: read and write access

* Unauthorized user: read access only
Protection level 3:

» Authorized users: read and write access

* Unauthorized user: no read and write access
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Project transfer

Overview There are the following possibilities for project transfer into the CPU:
» Transfer via MPI
» Transfer via Ethernet
» Transfer via MMC

Transfer via MPI For transfer via MPI the CPU has a MPI interface.

Net structure The structure of a MPI net is electrically identical with the structure of a
PROFIBUS net. This means the same rules are valid and you use the
same components for the build-up. The single participants are connected
with each other via bus interface plugs and PROFIBUS cables. Per default
the MPI net runs with 187.5kbaud. VIPA CPUs are delivered with MPI

address 2.
MPI programming The MPI programming cables are available at VIPA in different variants.
cable The cables provide a RS232 res. USB plug for the PC and a bus enabled

RS485 plug for the CPU.

Due to the RS485 connection you may plug the MPI programming cables
directly to an already plugged plug on the RS485 jack. Every bus
participant identifies itself at the bus with an unique address, in the course
of the address 0 is reserved for programming devices.

Terminating resistor A cable has to be terminated with its surge impedance. For this you switch
on the terminating resistor at the first and the last participant of a network or
a segment.
Please make sure that the participants with the activated terminating
resistors are always power supplied. Otherwise it may cause interferences
on the bus.

STEP7
"

[ |
I— ‘ Termination MPI net Termination

fe: =
[ {5 [ {oi
+— max.50m——»

MPI programming cable
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Approach transfer
via MPI

Transfer via
Ethernet

Initialization

Transfer

A maximum of 32 PG/OP connections is supported by MPI. The transfer via
MPI takes place with the following proceeding:

» Connect your PC to the MPI jack of your CPU via a MPI programming
cable.

* Load your project in the SIMATIC Manager from Siemens.

» Choose in the menu Options > Set PG/PC interface.

» Select in the according list the "PC Adapter (MPI)"; if appropriate you
have to add it first, then click on [Properties].

» Set in the register MPI the transfer parameters of your MPI net and type
a valid address.

» Switch to the register Local connection.

o Set the COM port of the PCs and the transfer rate 38400Baud for the
MPI programming cable from VIPA.

* Via PLC > Load to module you may transfer your project via MPI to the
CPU and save it on a MMC via PLC > Copy RAM to ROM if one is
plugged.

For transfer via Ethernet the CPU has the following interface:
» X&: Ethernet PG/OP channel

So that you may access the Ethernet PG/OP channel you have to assign IP
address parameters by means of the ‘initialization"(see "hardware
configuration - Ethernet PG/OP channel".

Information about the initialization of the Ethernet PG/OP channel may be
found at "Initialization of Ethernet PG/OP channel".

» For the transfer, connect, if not already done, the appropriate Ethernet
port to your Ethernet.

» Open your project with the Siemens SIMATIC Manager.
» Set via Options > Set PG/PC Interface the access path to "TCP/IP ->

Network card .... ".

» Click to PLC > Download — the dialog "Select target module" is opened.
Select your target module and enter the IP address parameters of the
Ethernet PG/OP channel for connection. Provided that no new hardware
configuration is transferred to the CPU, the entered Ethernet connection
is permanently stored in the project as transfer channel.

» With [OK] the transfer is started.

Note!

System dependent you get a message that the projected system differs
from target system. This message may be accepted by [OK].

— your project is transferred and may be executed in the CPU after
transfer.
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Transfer via
MMC

Transfer
MMC - CPU

Transfer
CPU - MMC

Transfer control

The MMC (Memory Card) serves as external transfer and storage medium.
There may be stored several projects and sub-directories on a MMC
storage module. Please regard that your current project is stored in the root
directory and has one of the following file names:

» S7PROG.WLD
* AUTOLOAD.WLD

With File > Memory Card File > New in the Siemens SIMATIC Manager a
new wld file may be created. After the creation copy the blocks from the
project blocks folder and the System data into the wid file.

The transfer of the application program from the MMC into the CPU takes
place depending on the file name after an overall reset or PowerON.

» S7PROG.WLD is read from the MMC after overall reset.
e AUTOLOAD.WLD is read after PowerON from the MMC.

The blinking of the LED "MCC" of the CPU marks the active transfer.
Please regard that your user memory serves for enough space, otherwise
your user program is not completely loaded and the SF LED gets on.

When the MMC has been installed, the write command stores the content
of the battery buffered RAM as STPROG.WLD on the MMC.

The write command is controlled by means of the block area of the
Siemens SIMATIC manager PLC > Copy RAM to ROM. During the write
process the "MCC"-LED of the CPU is blinking. When the LED expires the
write process is finished.

If this project is to be loaded automatically from the MMC with PowerON,
you have to rename this on the MMC to AUTOLOAD.WLD.

After a MMC access, an ID is written into the diagnostic buffer of the CPU.
To monitor the diagnosis entries, you select PLC > Module Information in
the Siemens SIMATIC Manager. Via the register "Diagnostic Buffer" you
reach the diagnosis window.

When accessing a MMC, the following events may occur:
Event-ID Meaning
0xE100 MMC access error

OxE101 MMC error file system
OxE102 MMC error FAT

OxE104 MMC-error with storing

0xE200 MMC writing finished successful

0xE210 MMC reading finished (reload after overall reset)
OxE21F Error during reload, read error, out of memory

4-16
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Access to the internal web page

Access to the

The Ethernet PG/OP channel provides a web page that you may access via

web page an Internet browser by its IP address. The web page contains information
about firmware versions, current cycle times etc.

The current content of the web page is stored on MMC by means of the
MMC-Cmd WEBPAGE. More information may be found at "MMC-Cmd -

Auto commands".

Requirements

A PG/OP channel connection should be established between PC with

Internet browser and CPU 312-5BE13. This may be tested by Ping to the IP
address of the Ethernet PG/OP channel.

Web page The access takes place via the IP address of the Ethernet PG/OP channel.
-2 9@ dla The web page only serves for information output. The monitored values are

Add | 1w g 23 not alterable.
IP PG/OP

CPU W TH ETHERNET PG OP

Sl ot 100

VI PA 312-5BE13 V3.5.4 Px000135. pkg,
SERI ALNUMBER 02118
SUPPORTDATA: PRODUCT V3290, HARDWARE . ..

OnBoar dEt hernet : MacAddress : 0020d5771524,

| P-Address : , SubnetMask : , Gateway :
Cpu state : RUN

Functi onRS485 X2 : MPI

Functi onRS485 X3 : PtP

Cycletine [mcroseconds] : m n=17000
cur=17000 ave=17000 nax=17000

MCC-Trial -Tinme: 70:23

Sl ot 202

VI PA DI 16/ DO8 V3. 2.9, SUPPORTDATA: PRODUCT. . .
SUPPORTDATA: PRODUCT V3290, Modul e Type ...

Address Input 124...125

Address Qutput 124...124
Sl ot 204

VI PA 2 COUNTERS V3. 2.9,

SUPPORTDATA: PRODUCT V3290, Mbdul e Type ...

Address I nput 768...783
Address Qutput 768...783

St andard Bus 8 Bit Mbde

Order no., firmware vers., package,
serial no.

Information for support

Ethernet PG/OP: Addresses

CPU state

RS485 function X2

RS485 function X3

CPU cycle time:

min= minimal, cur= current
ave= average, max= maximal

Remaining time for deactivation of the
expansion memory if MCC is removed.

Additional CPU components:

Slot 202 (Digital I/Os):

Name, firmware version, module type
Information for support

Configured input base addresses
Configured output base addresses
Slot 204 (Counter)

Name, firmware version, module type
Information for support

Configured input base addresses
Configured output base addresses

Modules at standard bus
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Operating modes

Overview

Operating mode
STOP

Operating mode
START-UP

Operating mode
RUN

The CPU can be in one of 4 operating modes:
» Operating mode STOP

» Operating mode START-UP

» Operating mode RUN

» Operating mode HOLD

Certain conditions in the operating modes START-UP and RUN require a
specific reaction from the system program. In this case the application
interface is often provided by a call to an organization block that was
included specifically for this event.

» The application program is not processed.

» If there has been a processing before, the values of counters, timers,
flags and the process image are retained during the transition to the
STOP mode.

» Outputs are inhibited, i.e. all digital outputs are disabled.
* RUN-LED off
« STOP-LED on

* During the transition from STOP to RUN a call is issued to the start-up
organization block OB 100. The processing time for this OB is not
monitored. The START-UP OB may issue calls to other blocks.

» All digital outputs are disabled during the START-UP, i.e. outputs are
inhibited.
* RUN-LED blinks as soon as the OB 100 is operated and for at least

3s, even if the start-up time is shorter or the CPU gets to
STOP due to an error. This indicates the start-up.

« STOP-LED off

When the CPU has completed the START-UP OB, it assumes the
operating mode RUN.

» The application program in OB 1 is processed in a cycle. Under the
control of alarms other program sections can be included in the cycle.

» All timers and counters being started by the program are active and the
process image is updated with every cycle.

» The BASP-signal (outputs inhibited) is deactivated, i.e. all digital outputs
are enabled.

* RUN-LED on
« STOP-LED off
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Operating mode
HOLD

Precondition

Approach for
working with
breakpoints

Behavior in
operating state
HOLD

The CPU offers up to 3 breakpoints to be defined for program diagnosis.
Setting and deletion of breakpoints happens in your programming
environment. As soon as a breakpoint is reached, you may process your
program step by step.

For the usage of breakpoints, the following preconditions have to be
fulfilled:

Testing in single step mode is only possible with STL. If necessary
switch the view via View > STL to STL.

The block must be opened online and must not be protected.
The open block must not be altered in the editor.

Activate View > Breakpoint Bar.

Set the cursor to the command line where you want to insert a
breakpoint.

Set the breakpoint with Debug > Set Breakpoint. The according
command line is marked with a circle.

To activate the breakpoint click on Debug > Breakpoints Active. The
circle is changed to a filled circle.

Bring your CPU into RUN. When the program reaches the breakpoint,
your CPU switches to the state HOLD, the breakpoint is marked with an
arrow and the register contents are monitored.

Now you may execute the program code step by step via Debug >
Execute Next Statement or run the program until the next breakpoint via
Debug > Resume.

Delete (all) breakpoints with the option Debug > Delete All Breakpoints.

The LED RUN blinks and the LED STOP is on.

The execution of the code is stopped. No level is further executed.
The real-time clock runs is just running.

The outputs were disabled (BASP is activated).

Configured CP connections remain exist.

Note!

The usage of breakpoints is always possible. Switching to the operating
mode test operation is not necessary.

With more than 2 breakpoints, a single step execution is not possible.
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Function The CPUs include security mechanisms like a Watchdog (100ms) and a
security parameterizable cycle time surveillance (parameterizable min. 1ms) that
stop res. execute a RESET at the CPU in case of an error and set it into a
defined STOP state.
The VIPA CPUs are developed function secure and have the following
system properties:
Event concerns Effect
RUN - STOP |general BASP (Befehls-Ausgabe-Sperre, i.e. command
output lock) is set.
central digital outputs The outputs are disabled.
central analog outputs The Outputs are disabled.
- Voltage outputs issue 0V
- Current outputs 0...20mA issue OmA
- Current outputs 4...20mA issue 4mA
If configured also substitute values may be
issued.
decentral outputs Same behavior as the central digital/analog
outputs.
decentral inputs The inputs are cyclically be read by the decentra-
lized station and the recent values are put at
disposal.
STOP - RUN |general First the Pll is deleted, then OB 100 is called. After

res. PowerON

the execution of the OB, the BASP is reset and the
cycle starts with:
Delete PIO - Read PIl - OB 1.

central analog outputs

The behavior of the outputs at restart can be
preset.

decentral inputs

The inputs are cyclically be read by the decentra-
lized station and the recent values are put at
disposal.

RUN

general

The program execution happens cyclically and can
therefore be foreseen:
Read PIl -~ OB 1 - Write PIO.

Pll = Process image inputs
PIQ = Process image outputs

4-20
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Overall reset

Overview

Overall reset by
means of the
function selector

During the overall reset the entire user memory (RAM) is erased. Data
located in the memory card is not affected.

You have 2 options to initiate an overall reset:
* initiate the overall reset by means of the function selector switch
* initiate the overall reset by means of the Siemens SIMATIC Manager

Note!

You should always issue an overall reset to your CPU before loading an
application program into your CPU to ensure that all blocks have been
cleared from the CPU.

Condition

The operating mode of the CPU is STOP. Place the function selector on the
CPU in position "STOP" - the STOP-LED is on.

Overall reset

* Place the function selector in the position MRES and hold it in this
position for app. 3 seconds. - The STOP-LED changes from blinking to
permanently on.

» Place the function selector in the position STOP and switch it to MRES
and quickly back to STOP within a period of less than 3 seconds.
— The STOP-LED blinks (overall reset procedure).

 The overall reset has been completed when the STOP-LED is on
permanently. — The STOP-LED is on.

The following figure illustrates the above procedure:

@ ©) ®

®

PLC PLC PLC PLC
PWR PWR PWR PWR
RUN RUN RUN RUN
N / N /
—J |stoP STOP —J |sFoP sToP
/ SN ~ 77T\ ~
SF SF SF SF
FRCE FRCE FRCE FRCE
N N N N
RUN RUN RUN RUN
o} o @ Yo (@
MRES MRES MRES MRES

3 Sec. |
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Automatic reload

Overall reset by
means of the
Siemens SIMATIC
Manager

Automatic reload

Set back to factory
setting

If there is a project STPROG.WLD on the MMC, the CPU attempts to
reload this project from MMC - the MCC LED is on.

When the reload has been completed the LED expires. The operating
mode of the CPU will be STOP or RUN, depending on the position of the
function selector.

Condition

The operating mode of the CPU must be STOP.
You may place the CPU in STOP mode by the menu command
PLC > Operating mode.

Overall reset

You may request the overall reset by means of the menu command PLC >
Clean/Reset.

In the dialog window you may place your CPU in STOP mode and start the
overall reset if this has not been done as yet.

The STOP-LED blinks during the overall reset procedure.

When the STOP-LED is on permanently the overall reset procedure has
been completed.

If there is a project STPROG.WLD on the MMC, the CPU attempts to
reload this project from MMC - the MCC LED is on.

When the reload has been completed, the LED expires. The operating
mode of the CPU will be STOP or RUN, depending on the position of the
function selector.

The following approach deletes the internal RAM of the CPU completely
and sets it back to the delivery state.

Please regard that the MPI address is also set back to default 2!
More information may be found at the part "Factory reset" further below.
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Firmware update

Overview

Latest Firmware at
www.vipa.de

By means of a MMC there is the opportunity to execute a firmware update
at the CPU and its components.

For this an accordingly prepared MMC must be in the CPU during the start-
up.

Thus a firmware file may be recognized and assigned with start-up, a pkg
file name is reserved for each updateable component and hardware
release, which begins with "px" and differs in a number with six digits. The
pkg file name of every updateable component may be found at a label right
down the front flap of the module.

After PowerON and CPU STOP the CPU checks if there is a *.pkg file on
the MMC. If this firmware version is different to the existing firmware
version, this is indicated by blinking of the LEDs and the firmware may be
installed by an update request.

Firmware package
and version

The latest 2 firmware versions may be found in the service area at
www.vipa.de.

For example the following file is necessary for the firmware update of the
CPU 312-5BE13 with hardware release 1: Px000135.pkg

Attention!

When installing a new firmware you have to be extremely careful. Under
certain circumstances you may destroy the CPU, for example if the voltage
supply is interrupted during transfer or if the firmware file is defective.

In this case, please call the VIPA-Hotline!

Please regard that the version of the update firmware is different to the
existing firmware otherwise no update is executed.
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Display the

Firmware version of
the SPEED7 system

viaweb page

Determine CPU
firmware version

with module

The 312-5BE13 has an integrated web page that monitors information
about firmware version of the /O components. The Ethernet PG/OP
channel provides the access to this web page.

To activate the PG/OP channel you have to enter according IP parameters.

This can be made in Siemens SIMATIC manager either by a hardware
configuration, loaded by MMC respectively MPI or via Ethernet by means of
the MAC address with PLC > Assign Ethernet Address.

After that you may access the PG/OP channel with a web browser via the
IP address of the project engineering. More detailed information is to find in
"Access to Ethernet PG/OP channel and website".

First establish an online connection to the CPU. To monitor the module
information you choose the option PLC > Module Information in the
Siemens SIMATIC Manager.

information Via the register "General" the window with hardware and firmware version
may be selected.
From software-technical reasons there is something different of the
CPU 312-5BE13 to the CPU 312C from Siemens:
The releases of hard and software may be found at "Order
No./Description". Here the number at "Version" is irrelevant.
Description: CPU 312C System identification: SIMATIC 300
Name: CPU 312C
Version: Order No./Description | Component Version
6ES7 312-5BE03 Hardware 1
VIPA AGO1 10V3.5.4 Firmware V2.6.0
Hardware:
Release —_— irrelevant
Sub version
Firmware:
Version
Note!

Every register of the module information dialog is supported by the VIPA
CPUs. More about these registers may be found in the online help of the
Siemens SIMATIC manager.
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Load firmware and
transfer it to MMC

Go to www.vipa.de.
Click on Service > Download > Firmware.

Navigate via System 300S > CPU to your CPU and download the zip file
to your PC.

Extract the zip file and copy the extracted pkg files to your MMC.

Attention!

With a firmware update an overall reset is automatically executed. If your
program is only available in the load memory of the CPU it is deleted! Save
your program before executing a firmware update! After the firmware
update you should execute a "Set back to factory settings" (see following

page).
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Transfer firmware 1.

from MMC into
CPU

Switch the operating mode switch of your CPU in position STOP. Turn
off the voltage supply. Plug the MMC with the firmware files into the
CPU. Please take care of the correct plug-in direction of the MMC.
Turn on the voltage supply.

2. After a short boot-up time, the alternate blinking of the LEDs SF and
FRCE shows that at least a more current firmware file was found on
the MMC.

3. You start the transfer of the firmware as soon as you tip the operating
mode switch downwards to MRES within 10s.

4. During the update process, the LEDs SF and FRCE are alternately
blinking and MMC LED is on. This may last several minutes.

5. The update is successful finished when the LEDs PWR, STOP, SF,
FRCE and MCC are on. If they are blinking fast, an error occurred.

6. Turn Power OFF and ON. Now it is checked by the CPU, whether
further current firmware versions are available at the MMC. If so, again
the LEDs SF and FRCE flash after a short start-up period. Continue
with point 3.

If the LEDs do not flash, the firmware update is ready.
Now a factory reset should be executed (see next page). After that the
CPU is ready for duty.
Preparation Firmware Start update Update runs Update Error
recognized terminates
l RUN at MMC error free
sTOP PLC PLC PLC PLC PLC PLC
EPwrR  [HPWR EPwr  [EPWR EPwWR PWR
MRES — — ] ] .
[ |RUN [ |RUN [ |RUN [ |IRUN [ |RUN RUN
l N :ST/OP [_|sToP N :ST/OP [|sTopP |stoP E §{OP
S s u - Jms i - s
Insert MMC /?EECE:EE;’;CE Tip RUN RUN /;gfsCE::E;’:{CE =:ZCE - %ZCE
Hmce s —vce l — STOP ismp Mcc 7 :MSC [ mMcc z g@c Power
Power OFF/ON B Ol MRES MRES | ] u u “I7 Y OFF/ON
|_10Sec. |
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Factory reset

Proceeding With the following proceeding the internal RAM of the CPU is completely
deleted and the CPU is reset to delivery state.

Please note that here also the IP address of the Ethernet PG/OP channel is
set to 0.0.0.0 and the MPI address is reset to the address 2!

A factory reset may also be executed by the MMC-Cmd FACTORY_
RESET. More information may be found at "MMC-Cmd - Auto commands".

1.  Switch the CPU to STOP.

2. Push the operating switch down to position MRES for 30s. Here the
STOP-LED flashes. After a few seconds the stop LED changes to
static light. Now the STOP LED changes between static light and
flashing. Starting here count the static light states.

3. After the 6. static light release the operating mode switch and tip it
downwards to MRES. Now the RUN LED lights up once. This means
that the RAM was deleted completely.

4. For the confirmation of the resetting procedure the LEDs PWR, STOP,
SF, FRCE and MCC get ON. If not, the factory reset has failed and
only an overall reset was executed. In this case you can repeat the
procedure. A factory reset can only be executed if the stop LED has
static light for exactly 6 times.

5. The end of factory reset is shown by static light of the LEDs STOP, SF,
FRCE and MCC. Switch the power supply off and on.

The proceeding is shown in the following lllustration:

oo © O ®

CPUin Request factory reset Start factory reset Factory reset  Error: Only
STOP executed overall reset
executed
PLC PLC PLC PLC PLC PLC
EPwWR EPwR EPwWR EPwr [EPWR EPwWR
[ |RUN [ |RUN [ |RUN EIRUN [ |RUN [ |RUN
| |sTOP > :éx/op | |sTOP [ |sToP [ |sTOP | |sTOP
sk “HsF @ sk sk MsF sk
|_IFRCE T'p |_|FRCE :FRCE RUN- Tip | |[FRCE [ _|FRCE |_IFRCE
Mcc ~STOP mce Mcc i sToP l @ STOP Myce  [Mcc Mcc Power
u MRES [ ] MRES MRES [ ] ] ] OFF/ON
30 Sec. | | 1 Sec.
Note!

After the firmware update you always should execute a Factory reset.
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Slot for storage media

Overview

Accessing the
storage medium

After overall reset

After PowerON

At the front of the CPU there is a slot for storage media. As external
storage medium for applications and firmware you may use a multimedia
card (MMC) or a VIPA MCC memory extension card. The MCC can
additionally be used as an external storage medium.

It has the PC compatible FAT16 file format.

You can cause the CPU to load a project automatically respectively to
execute a command file by means of pre-defined file names.

To the following times an access takes place on a storage medium:

» The CPU checks if there is a project STPROG.WLD. If exists the project
is automatically loaded.

» The CPU checks if there is a project PROTECT.WLD with protected
blocks. If exists the project is automatically loaded. These blocks are
stored in the CPU until the CPU is reset to factory setting or an empty
PROTECT.WLD is loaded.

* The CPU checks if a MCC memory extension card is put. If exists the
memory extension is enabled, otherwise a memory expansion, which
was activated before, is de-activated.

» The CPU checks if there is a project AUTOLOAD.WLD. If exists an
overall reset is established and the project is automatically loaded.

» The CPU checks if there is a command file with VIPA_CMD.MMC. [f
exists the command file is loaded and the containing instructions are
executed.

» After PowerON and CPU STOP the CPU checks if there is a *.pkg file
(firmware file). If exists this is indicated by blinking of the LEDs and the
firmware may be installed by an update request (see "Firmware update).

Once in STOP « If a storage medium is put, which contains a command file
VIPA_CMD.MMC, the command file is loaded and the containing
instructions are executed.
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Memory extension with MCC

Overview

VIPA 953-1LPoo

Approach

Behavior

With the SC CPU there is the possibility to extend the work memory of
your CPU.

For this, a MCC memory extension card is available from VIPA. The MCC
is a specially prepared MMC (Multimedia Card). By plugging the MCC into
the MCC slot and then an overall reset the according memory expansion is
released. There may only one memory expansion be activated at the time.
On the MCC there is the file memory.key. This file may not be altered or
deleted. You may use the MCC also as "normal" MMC for storing your
project.

To extend the memory, plug the MCC into the card slot at the CPU labeled
with "MCC" and execute an overall reset.

CPU Overall reset

vee _ﬂ:ﬂ @ b= @1"

= memory is extended for the MCC memory
configuration (diagnostic entry 0xE400)

If the memory expansion on the MCC exceeds the maximum extendable
memory range of the CPU, the maximum possible memory of the CPU is
automatically used.

You may determine the recent memory extension via the Siemens
SIMATIC Manager at Module Information - "Memory".

Attention!

Please regard that the MCC must remain plugged when you've executed
the memory expansion at the CPU. Otherwise the CPU switches to STOP
after 72h. The MCC can not be exchanged with a MCC of the same
memory configuration.

When the MCC memory configuration has been taken over you may find
the diagnosis entry 0xE400 in the diagnostic buffer of the CPU.

After pulling the MCC the entry 0xE401 appears in the diagnostic buffer,
the SF-LED is on and after 72h the CPU switches to STOP. A reboot is
only possible after plugging-in the MCC again or after an overall reset.
After re-plugging the MCC, the SF-LED extinguishes and OxE400 is
entered into the diagnostic buffer.

You may reset the memory configuration of your CPU to the initial status at
any time by executing an overall reset without MCC.

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12 4-29



Chapter 4 Deployment CPU 312-5BE13 Manual VIPA System 300S SPEED7

Extended know-how protection

Overview

Standard protection

Extended protection

PC

Blocks

wid file —

Protect blocks
with protect.wld

Besides the "standard" Know-how protection the CPU from VIPA provide
an "extended" know-how protection that serves a secure block protection
for accesses of 3™ persons.

The standard protection from Siemens transfers also protected blocks to
the PG but their content is not displayed. But with according manipulation
the Know-how protection is not guaranteed.

The "extended" know-how protection developed by VIPA offers the
opportunity to store blocks permanently in the CPU.

At the "extended" protection you transfer the protected blocks into a WLD-
file named protect.wld. By plugging the MMC and following overall reset,
the blocks in the protect.wld are permanently stored in the CPU.

You may protect OBs, FBs and FCs.

When back-reading the protected blocks into the PG, exclusively the block
header are loaded. The block code that is to be protected remains in the
CPU and cannot be read.

CPU OVERALL_RESET

=l @@ @i

ey | MMC | iy — > protected Blocks
are located in the CPU
protect.wld

Create a new wild-file in your project engineering tool with File > Memory
Card file > New and rename it to "protect.wld".

Transfer the according blocks into the file by dragging them with the mouse
from the project to the file window of protect.wid.

4-30

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12



Manual VIPA System 300S SPEED7

Chapter 4 Deployment CPU 312-5BE13

Transfer

protect.wld to CPU

with overall reset

Protection
behavior

Change respectively
delete protected
blocks

Usage of
protected blocks

Transfer the file protect.wld to a MMC storage module, plug the MMC into
the CPU and execute an overall reset with the following approach:

@

©)

©

@

PLC PLC PLC PLC
[ ]PWR [ ]PWR [ ]PWR ]PWR
| |RUN | |RUN | |RUN | |RUN
N7 — N7 —
—J |StoP JISTOP J ISToP JsTOP
/ /:\ N /7\ / /:\ N /:\
| |SsF | |sF _|SF | |SF
|_|FRCE |_|FRCE | |FRCE |_|FRCE
IRV a¥al IV a¥al [V Ta¥al IV Ta¥al
RUN RUN RUN RUN
MRES MRES MRES MRES

| 3 Sec. |

The overall reset stores the blocks in protect.wld permanently in the CPU
protected from accesses of 3. persons.

Protected blocks are overwritten by a new protect.wid.

Using a PG 3™ persons may access protected blocks but only the block
header is transferred to the PG. The block code that is to protect remains in
the CPU and can not be read.

Protected blocks in the RAM of the CPU may be substituted at any time by
blocks with the same name. This change remains up to next overall reset.
Protected blocks may permanently be overwritten only if these are deleted
at the protect.wld before.

By transferring an empty protect.wld from the MMC you may delete all
protected blocks in the CPU.

Due to the fact that reading of a "protected" block from the CPU monitors
no symbol labels it is convenient to provide the "block covers" for the end
user.

For this, create a project out of all protected blocks. Delete all networks in
the blocks so that these only contain the variable definitions in the
according symbolism.
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MMC-Cmd - Auto commands

Overview

Command file

Commands

A command file at a MMC is once executed until the next PowerON under
the following conditions:

« CPUisin STOP and MMC is stuck
» After PowerON with operating switch in STOP

The command file is a text file, which consists of a command sequence to
be stored as vipa_cmd.mmc in the root directory of the MMC.

The file has to be started by CMD_START as 1. command, followed by the
desired commands (no other text) and must be finished by CMD_END as
last command.

Text after the last command CMD_END e.g. comments is permissible,
because this is ignored. As soon as the command file is recognized and
executed each action is stored at the MMC in the log file lodfile.txt. In
addition for each executed command a diagnostics entry may be found in
the diagnostics buffer.

Please regard the command sequence is to be started with CMD_START
and ended with CMD_END.

Command

Description Diagnostics entry

CMD_START

In the first line CMD_START is to be located. 0xE801

There is a diagnostic entry if CMD_START is missing OxE8FE

WAIT1SECOND

Waits ca. 1 second. 0OxE803

WEBPAGE

The current web page of the CPU is stored at the MMC OxE804

as "webpage.htm".

LOAD_PROJECT

The function "Overall reset and reload from MMC" is OxE805
executed. The wid file located after the command is

loaded else "s7prog.wld" is loaded.

SAVE_PROJECT

The recent project (blocks and hardware configuration) 0xE806
is stored as "s7prog.wld" at the MMC.

If the file just exists it is renamed to "s7prog.old".

If your CPU is password protected so you have to add
this as parameter. Otherwise there is no project written.

Example: SAVE_PROJECT password

FACTORY_RESET

Executes "factory reset". 0xE807

DIAGBUF

The current diagnostics buffer of the CPU is stored as OxE80B

"diagbuff.txt" at the MMC.

SET_NETWORK

IP parameters for Ethernet PG/OP channel may be set OxE8OE
by means of this command.

The IP parameters are to be given in the order IP
address, subnet mask and gateway in the format

XXX.XXX.XXX.XXX each separated by a comma.
Enter the IP address if there is no gateway used.

CMD_END

0xE802

In the last line CMD _END is to be located.
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Examples

The structure of a command file is shown in the following. The

corresponding diagnostics entry is put in parenthesizes.

Example 1

CVD_START

LOAD PRQJIECT proj.w d
VWAl T1SECOND

VEBPAGE

DI AGBUF

CVD_END

arbitrary text

Example 2

CMD_START
LOAD_PRQJECT proj 2. W d
WAl T1SECOND

WAl T1SECOND

SET_NETWORK 172. 16. 129. 210, 255. 255. 224. 0, 172. 16. 129. 210

WAl T1SECOND
WAl T1SECOND
WEBPAGE
DI AGBUF
CMVD_END

arbitrary text

Note!

Marks the start of the command sequence (0xE801)

Execute an overall reset and load "proj.wld" (OXE805)

Wait ca. 1s (OxE803)

Store web page as "webpage.htm" (0xE804)

Store diagnostics buffer of the CPU as "diagbuff.txt" (OXE80B)
Marks the end of the command sequence (0xE802)

Text after the command CMD_END is not evaluated.

Marks the start of the command sequence (0xE801)

Execute an overall reset and load "proj2.wld" (OXE805)

Wait ca. 1s (OXE803)

Wait ca. 1s (OxE803)

IP parameter
(OXE8OE)
Wait ca. 1s (OxE803)

Wait ca. 1s (OxE803)

Store web page as "webpage.htm" (0xE804)

Store diagnostics buffer of the CPU as "diagbuff.txt" (0xE80B)
Marks the end of the command sequence (0xE802)

Text after the command CMD_END is not evaluated.

The parameters IP address, subnet mask and gateway may be received
from the system administrator.

Enter the IP address if there is no gateway used.
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VIPA specific diagnostic entries

Entries in the
diagnostic buffer

Monitoring the
diagnostic entries

You may read the diagnostic buffer of the CPU via the Siemens SIMATIC
Manager. Besides of the standard entries in the diagnostic buffer, the VIPA
CPUs support some additional specific entries in form of event-IDs.

The current content of the diagnostics buffer is stored on MMC by means of
the MMC-Cmd DIAGBUF. More information may be found at "MMC-Cmd -
Auto commands".

Note!

Every register of the module information is supported by the VIPA CPUs.
More information may be found at the online help of the Siemens SIMATIC
manager.

To monitor the diagnostic entries you choose the option PLC > Module
Information in the Siemens SIMATIC Manager. Via the register "Diagnostic
Buffer" you reach the diagnostic window:

EModuIe information j

Path: Accessible Nodes MPI = 2 Operating mode CPU: RUN

Diagnostic Buff4r | ‘

Nr. Time of day Date Event
9

10 13:18:11:370 19.12.2011 Event-ID: 16# EOCC \

i - - VIPA-

Details:

O

The diagnosis is independent from the operating mode of the CPU. You
may store a max. of 100 diagnostic entries in the CPU.

The following page shows an overview of the VIPA specific Event-IDs.
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Overview of the
Event-IDs

Event-ID | Description

OxE003 Error at access to I/O devices
Zinfo1: 1/O address
Zinfo2: Slot

0xEO004 | Multiple parameterization of a I/O address
Zinfo1: 1/0 address
Zinfo2: Slot

OxE005 Internal error - Please contact the VIPA-Hotline!

OxEO006 Internal error - Please contact the VIPA-Hotline!

0xE007 | Configured in-/output bytes do not fit into I/O area

OxEO008 Internal error - Please contact the VIPA-Hotline!

0xE009 | Error at access to standard back plane bus

0xEO010 | Not defined module group at backplane bus recognized
Zinfo2: Slot
Zinfo3: Type ID

0xE011 Master project engineering at Slave-CPU not possible or wrong slave configuration

0xEOQ12 | Error at parameterization

O0xE013 | Error at shift register access to standard bus digital modules

0xEO014 | Error at Check Sys

0xEO015 | Error at access to the master
Zinfo2: Slot of the master (32=page frame master)

OxEO16 Maximum block size at master transfer exceeded
Zinfo1: I/O address
Zinfo2: Slot

0xEQ17 | Error at access to integrated slave

0xE018 | Error at mapping of the master periphery

0xEO019 | Error at standard back plane bus system recognition

OXEOQ1A | Error at recognition of the operating mode (8 / 9 Bit)

0xEOQ1B | Error - maximum number of plug-in modules exceeded

0xE020 | Error - interrupt information is not defined

OxEO030 Error of the standard bus

0OxE033 Internal error - Please contact the VIPA-Hotline!

OxEOBO | SPEED?Y is not stoppable (probably undefined BCD value at timer)

0xEOCO | Not enough space in work memory for storing code block (block size exceeded)

OxEOCC | Communication error MPI / Serial
Zinfo1: Code

1: Wrong Priority

2: Buffer overflow

3: Frame format error

7: Incorrect value

8: Incorrect RetVal

9: Incorrect SAP

10: Incorrect connection type

11: Incorrect sequence number

12: Faulty block number in the telegram
13: Faulty block type in the telegram
14: Inactive function

15: Incorrect size in the telegram
20: Error writing to MMC

90: Incorrect Buffer size

98: Unknown error

99: Internal error
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Event-ID | Description
OxEOCD | Error at DPV1 job management
OxEOCE | Error: Timeout at sending of the i-slave diagnostics
0xE100 | MMC access error
0xE101 MMC error file system
0xE102 | MMC error FAT
0xE104 | MMC error at saving
0xE200 | MMC writing finished (Copy Ram2Rom)
0xE210 | MMC reading finished (reload after overall reset)
0xE21F | MMC reading: error at reload (after overall reset), read error, out of memory
0xE300 | Internal flash writing finished (Copy Ram2Rom)
0xE310 |Internal flash writing finished (reload after battery failure)
0xE400 | Memory expansion MCC has been plugged
0xE401 Memory expansion MCC has been removed
0xE801 MMC-Cmd: CMD_START recognized and successfully executed
0xE802 | MMC-Cmd: CMD_END recognized and successfully executed
0xE803 | MMC-Cmd: WAIT1SECOND recognized and successfully executed
0xE804 | MMC-Cmd: WEBPAGE recognized and successfully executed
0xE805 |MMC-Cmd: LOAD PROJECT recognized and successfully executed
0xE806 | MMC-Cmd: SAVE_PROJECT recognized and successfully executed
0xE807 |MMC-Cmd: FACTORY_RESET recognized and successfully executed
0xE80B | MMC-Cmd: DIAGBUF recognized and successfully executed
OxE80E |MMC-Cmd: SET NETWORK recognized and successfully executed
OxE8FB | MMC-Cmd: Error: Initialization error of the Ethernet-PG/OP channel by means of
SET_NETWORK.
O0xE8FC | MMC-Cmd: Error: Some IP parameters are missing in SET NETWORK.
OxE8FE | MMC-Cmd: Error: CMD_START is missing
OXE8FF | MMC-Cmd: Error: Error while reading CMD file (MMC error)
0xE901 Check sum error
OxEAQQ |Internal error - Please contact the VIPA-Hotline!
OxEAO01 Internal error - Please contact the VIPA-Hotline!
OxEAO02 | SBUS: Internal error (internal plugged sub module not recognized)
Zinfo1: Internal slot
OXEAO03 | SBUS: Communication error CPU - PROFINET-IO-Controller
Zinfo1: Slot
Zinfo2: Status (0: OK, 1: ERROR, 2: BUSSY, 3: TIMEOUT, 4: LOCKED, 5: UNKNOWN)
OxEAO04 | SBUS: Multiple parameterization of a I/O address
Zinfo1: 1/0 address
Zinfo2: Slot
Zinfo3: Data width
OXEAO05 |Internal error - Please contact the VIPA-Hotline!
OxEAQ7 |Internal error - Please contact the VIPA-Hotline!
OXEA08 | SBUS: Parameterized input data width unequal to plugged input data width
Zinfo1: Parameterized input data width
Zinfo2: Slot
Zinfo3: Input data width of the plugged module
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Event-ID | Description
OxEAQ9 |SBUS: Parameterized output data width unequal to plugged output data width
Zinfo1: Parameterized output data width
Zinfo2: Slot
Zinfo3: Output data width of the plugged module
OxEA10 | SBUS: Input address outside input area
Zinfo1: 1/0 address
Zinfo2: Slot
Zinfo3: Data width
OxEA11 | SBUS: Output address outside output area
Zinfo1: 1/0O address
Zinfo2: Slot
Zinfo3: Data width
OxEA12 | SBUS: Error at writing record set
Zinfo1: Slot
Zinfo2: Record set number
Zinfo3: Record set length
OxEA14 | SBUS: Multiple parameterization of a I/O address (Diagnostic address)
Zinfo1: 1/0 address
Zinfo2: Slot
Zinfo3: Data width
OxEA15 |Internal error - Please contact the VIPA-Hotline!
OxEA18 | SBUS: Error at mapping of the master I/O devices
Zinfo2: Master slot
OxEA19 |Internal error - Please contact the VIPA-Hotline!
OXEA20 |Error - RS485 interface is not set to PROFIBUS DP master but there is a
PROFIBUS DP master configured.
O0xEA21 | Error - Project engineering RS485 interface X2/X3:
PROFIBUS DP master is configured but missing
Zinfo2: Interface x
OxEA22 | Error - RS485 interface X2 - value is out of range
Zinfo: Configured value X2
OxEA23 |Error - RS485 interface X3 - value is out of range
Zinfo: Configured value X3
OxEA24 | Error - Project engineering RS485 interface X2/X3:
Interface/Protocol is missing, the default settings are used.
Zinfo2: Configured value X2
Zinfo3: Configured value X3
OxEA30 |Internal error - Please contact the VIPA-Hotline!
OxEA40 |Internal error - Please contact the VIPA-Hotline!
OxEA41 Internal error - Please contact the VIPA-Hotline!
OxEA50 |Error - PROFINET configuration
Zinfo1: User slot of the PROFINET IO controller
Zinfo2: 10 device number
Zinfo3: 10 device slot
OXEAS51 | Error - there is no PROFINET 10 controller at the configured slot
Zinfo1: User slot of the PROFINET IO controller
Zinfo2: Recognized ID at the configured slot
OxEA54 |Error - PROFINET IO controller reports multiple configuration at one peripheral addr.

Zinfo1: Peripheral address
Zinfo2: User slot of the PROFINET IO controller
Zinfo3: Data width
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Event-ID | Description

OxEA64 |PROFINET configuration error:
Zinfo1: error word

Bit 0: too many IO devices

Bit 1: too many 10 devices per ms

Bit 2: too many input bytes per ms

Bit 3: too many output bytes per ms

Bit 4: too many input bytes per device

Bit 5: too many output bytes per device

Bit 6: too many productive connections

Bit 7: too many input bytes in the process image
Bit 8: too many output bytes in the process image
Bit 9: Configuration not available

Bit 10: Configuration not valid

OxEA65 | Communication error CPU - PROFINET-IO-Controller
Pk : CPU or PROFINET-IO-Controller

Zinfo1: Service ID, with which the error arose

Zinfo2: Command, with which the error arose

OxEA66 Internal error - Please contact the VIPA-Hotline!

OxEA67 |Error - PROFINET-IO-Controller - reading record set
Pk: Error type

0: DATA_ RECORD _ERROR_LOCAL

1: DATA_RECORD_ERROR_STACK

2: DATA_ RECORD_ERROR_REMOTE

OBNr: PROFINET-IO-Controller slot

Datld: Device no.

Zinfo1: Record set number

Zinfo2: Record set handle

Zinfo3: Internal error code for service purposes

OxEA68 |Error - PROFINET-IO-Controller - writing record set
Pk: Error type

0: DATA_ RECORD _ERROR_LOCAL

1: DATA_RECORD_ERROR_STACK

2: DATA_ RECORD_ERROR_REMOTE

OBNr: PROFINET-IO-Controller slot

Datld: Device no.

Zinfo1: Record set number

Zinfo2: Record set handle

Zinfo3: Internal error code for service purposes

OxEA97 | Storage error SBUS service channel
Zinfo3 = Slot

OxEA98 | Timeout at waiting for reboot of a SBUS module (Server)

OxEA99 |Error at file reading via SBUS

OxEEOO |Additional information at UNDEF_OPCODE

OxEEEE | CPU was completely overall reset, since after PowerON the start-up could not be
finished.

OxEFFF Internal error - Please contact the VIPA-Hotline!
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Using test functions for control and monitoring of variables

Overview

Debug > Monitor

For troubleshooting purposes and to display the status of certain variables
you can access certain test functions via the menu item Debug of the
Siemens SIMATIC Manager.

The status of the operands and the VKE can be displayed by means of the
test function Debug > Monitor.

You can modify and/or display the status of variables by means of the test
function PLC > Monitor/Modify Variables.

This test function displays the current status and the VKE of the different
operands while the program is being executed.

It is also possible to enter corrections to the program.

Note!
When using the test function “Monitor” the PLC must be in RUN mode!

The processing of statuses can be interrupted by means of jump
commands or by timer and process-related alarms. At the breakpoint the
CPU stops collecting data for the status display and instead of the required
data it only provides the PG with data containing the value 0.

For this reason, jumps or time and process alarms can result in the value
displayed during program execution remaining at 0 for the items below:

+ the result of the logical operation VKE

» Status / AKKU 1

+ AKKU 2

» Condition byte

» absolute memory address SAZ. In this case SAZ is followed by a "?".

The interruption of the processing of statuses does not change the
execution of the program. It only shows that the data displayed is no longer.
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PLC >
Monitor/Modify
Variables

This test function returns the condition of a selected operand (inputs,
outputs, flags, data word, counters or timers) at the end of program-
execution.

This information is obtained from the process image of the selected
operands. During the "processing check" or in operating mode STOP the
periphery is read directly from the inputs. Otherwise only the process image
of the selected operands is displayed.

Control of outputs
It is possible to check the wiring and proper operation of output-modules.

You can set outputs to any desired status with or without a control program.
The process image is not modified but outputs are no longer inhibited.

Control of variables
The following variables may be modified:
,Q, M, T,CandD.

The process image of binary and digital operands is modified independently
of the operating mode of the SC CPU.

When the operating mode is RUN the program is executed with the
modified process variable. When the program continues they may,
however, be modified again without naotification.

Process variables are controlled asynchronously to the execution sequence
of the program.

4-40
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Chapter 5

Overview

Content

Deployment I/O periphery

This chapter contains all information necessary for the employment of the
in-/output periphery of the CPU 312-5BE13. It describes functionality,
project engineering and diagnostic of the analog and digital part.
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Overview

Hardware

Project
engineering

I/O periphery

Technological
functions

At the CPU 312-5BE13 the connectors for digital in-/output and
technological functions are integrated to a 2tier casing.

The project engineering takes place in the Siemens SIMATIC manager as
CPU 312C from Siemens (6ES7 312-5BE03-0AB0 V2.6).

Here the CPU is parameterized by the "Properties" dialog of the
CPU 312C.

For parameterization of the digital 1/O periphery and the technological
functions the corresponding submodule of the CPU 312C may be used.

The integrated 1/Os of the CPU 312-5BE13 may be used for technological
functions or as standard 1/Os.

Technological functions and standard 1/0Os may be used simultaneously
with appropriate hardware. Read access to inputs used by technological
functions is possible. Write access to used outputs is not possible.

Up to 2 channels may be parameterized as technological function. The
parameterization of the appropriate channel is made in the hardware
configurator by the count submodule of the CPU 312C.

There are the following technological functions:
» Continuous count

» Single count

» Periodic count

The controlling of the corresponding counter mode happens by means of
the SFB COUNT (SFB 47) of the user program.

5-2
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In-/Output range CPU 312-5BE13

Overview
CPU 312-5BE13

The CPU 312-5BE13 has the following analog and digital in- and output
ranges integrated in one casing:

» Digital Input: 16xDC 24V
» Digital Output: 8xDC 24V, 0.5A
» Technological functions: 2 Channels

Each of the digital in-/ outputs monitors its state via a LED. Via the
parameterization you may assign alarm properties to every digital input.
Additionally the digital inputs are parameterizable as counter.

X11:

1 1L+ 21 2L+

2 &Di
3 — | 23 D
4~ | %7
s ] % 1 C—
6 - DO — 2
- | %
8 — | 224['7
S 30

2M
DI —| (=

2 |
13— |
14— |
5 |
6 |
17w -
18— |
19 |

| 20 1™

Attention!

Please take care that the voltage at an output channel always is < the
supply voltage via L+.

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12 5-3



Chapter 5 Deployment I/O periphery

Manual VIPA System 300S SPEED7

CPU 312-5BE13: Pin assignment and status indicator
Pin Assignment

PO Ao ©O®NO O AN

N ) a2 a A a a
O © 0o N O O b

Power supply +DC 24V

1+0.0 / Channel 0 (A)/Pulse
1+0.1 / Channel 0 (B)/Direction
1+0.2 / Channel 0 HW gate
1+0.3 / Channel 1 (A)/Pulse
1+0.4 / Channel 1 (B)/Direction
1+0.5 / Channel 1 HW gate
1+0.6

1+0.7

not connected

not connected

1+1.0

I+1.1

1+1.2

1+1.3

I1+1.4 / Channel 0 Latch

I1+1.5 / Channel 1 Latch

1+1.6

+1.7

Ground 1M DI

Connection
1 1L+

LEDs

DI16x DO8x

— 2 -

DI —

+
o

DC24v  DC24V

,—'O,SA :I\I_+2L+

o

£
1

MTNo o b wN =

Y
T

N Y I 4

~No b WON -2 O

[T T T T rrririris

9
o)
(®)

N ¥ O 9

9
o)
o

CPU 312-5BE13: Pin assignment and status indicator
Pin Assignment

21
22
23
24
25
26
27
28
29
30
31
32
33
34
35
36
37
38
39
40

Power supply +DC 24V
Q+0.0 / Channel 0 Output
Q+0.1/ Channel 1 Output
Q+0.2 / Channel 2 Output
Q+0.3

Q+0.4

Q+0.5

Q+0.6

Q+0.7

Ground 2M DO

not connected

not connected

not connected

not connected

not connected

not connected

not connected

not connected

not connected

not connected

DO —

Connection
21 2L+

(n)

LEDs

DI16x DO8x .
DC24v  DC24V,—

—0oA L

|

1L2L+4
—

No okl wido o

—_— 2L+

— 1L+

Dl:
L1+

DO:
L2+

LED (green)
Supply voltage
available for DI

LEDs (green)
[+0.0 to [+0.7
resp. 1+1.0 to
+1.7
Starting with
app. 15V the
signal "1" at
the input is
recognized
and the
according
LED

LED (green)
Supply voltage
available for
DO

LEDs (green)
Q+0.0 to
Q+0.7

on at active
output

LED (red)
Overload or
short circuit
error
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Address assignment

Input range
Sub module Default- Access Assignment
Address
DI10/DO6 124 Byte Digital Input 1+0.0 ... 1+0.7
125 Byte Digital Input 1+1.0 ... I1+1.7
Counter 768 Dint Channel 0: Count value / Frequency value
772 Dint Channel 1: Count value / Frequency value
776 Dint reserved
780 Dint reserved
Output range
Sub module Default- Access Assignment
Address
DI10/DO6 124 Byte Digital Output Q+0.0 ... Q+0.7
Counter 768 DWord reserved
772 DWord reserved
776 DWord reserved
780 DWord reserved
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Digital part

Digital part
CPU 312-5BE13

The digital part consists of 16 input -, 8 output channels and 2 channels for
technological functions. Each of these digital input- respectively output
channels show its state via a LED. By means of the parameterization you
may assign interrupt properties to the inputs 1+0.0 to [+1.7.

CPU 312-5BE13: Pin assignment and status indicator

Pin Assignment

Connection LEDs

1 Power supply +DC 24V 1 1L Dex  DOBX ., g DI:
2 140.0 / Channel 0 (A)/Pulse —2 —osn [Juef ]| — e L1+ ;ED (Igreel?)
3 1+0.1/ Channel 0 (B)/Direction s =0k upply voltage
R available for DI
4 1+0.2/Channel 0 HW gate —— 2L
5 1+0.3 / Channel 1 (A)/Pulse S = 3 Hl—w0.7 .0 7 LEDs (green)
L 6 4
6 1+0.4 / Channel 1 (B)/Direction 1 =[5 [+0.0 to 1+0.7
7 — [ L
7 1+0.5/Channel 1 HW gate ] e [] resp. [+1.0 to
8 1+06 8 \_;_}7 L [+1.7
9 1+0.7 — 5 o Starting with
10 not connected B (= . app. 1?\/"the
DI SR signal "1" at
11 not connected A : ;
2 | Mo the input is
12 1+1.0 N ] O 0 recognized
13 1+1.1 y N L f2 [ and the
14 1+1.2 s | according LED
15 1+1.3 T =t =
6 | 5
16 1+1.4/ Channel 0 Latch 17 ] e [
17 1+1.5/ Channel 1 Latch . Inpan
18 [+1.6 19— | DI DO
19 [+1.7 20 ™
20 Ground 1M DI B
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CPU 312-5BE13: Pin assignment and status indicator

Pin Assignment

21 Power supply +DC 24V
22 Q+0.0/ Channel 0 Output
23 Q+0.1/ Channel 1 Output
24 Q+0.2/ Channel 2 Output
25 Q+0.3

26 Q+04
27 Q+0.5
28 Q+0.6
29 Q+0.7

30 Ground 2M DO
31 not connected
32 not connected
33 not connected
34 not connected
35 not connected
36 not connected
37 not connected
38 not connected
39 not connected
40 not connected

Access to the

Connection LEDs
2 2+ [Dilex  DOBX .. .o DO:
DC24v  DCaav® % oL+ L2+
2 —PO5A | |12t )
24 D L -r L
25 ] C e
1 2 = I ] —
Do = L 4] 0t 0...7
27 = 4 M
L 4
29 =+ [
D = AN SR
| 30 F F
M DI DO
LA
o[
Ll F
2]
L] 3]
4]
L] 5]
L 6]
L7
oL

LED (green)
Supply voltage
available for
DO

LEDs (green)
Q+0.0 to
Q+0.7

resp. Q+1.0 to
Q+1.7

on at active
output

LED (red)
Overload or
short circuit
error

The CPU 312-5BE13 creates in its peripheral area an area for input

digital part respectively output data. Without a hardware configuration the in the
following specified default addresses are used.
Input range
Sub module Default Access Assignment
address
DI10/DO8 124 Byte Digital Input 1+0.0 ... 14+0.7
125 Byte Digital Input 1+1.0 ... 1+1.7
Count 768 Dint Channel 0: Count value / Frequency value
772 Dint Channel 1: Count value / Frequency value
776 Dint reserved
780 Dint reserved
Output range
Sub module Default Access Assignment
address
DI10/DO8 124 Byte Digital Output Q+0.0 ... Q+0.7
Count 768 DWord reserved
772 DWord reserved
776 DWord reserved
780 DWord reserved
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Digital part - Parameterization

Parameter data

General

Addresses

Inputs

Hardware interrupt

Input delay

Parameters of the digital part may be set by means of the DI10/DO6
submodule of the CPU 312C from Siemens during hardware configuration.

In the following all parameters are specified, which may be used with the
hardware configuration of the digital periphery.

This provides the short description of the digital periphery. At Comment
information about the module such as purpose may be entered.

At this register the start address of the in-/output periphery may be set.

Here there are the following adjustment possibilities:

* Hardware interrupt

* Input delay

For the digital output channels there are no parameters.

A hardware interrupt may be optionally triggered on the rising or falling
edge of an input.

A diagnostic interrupt is only supported together with hardware interrupt
lost.

Select with the arrow keys the input and activate the desired hardware
interrupt.

The input delay may be configured per channel in groups of four. Please
note that in the parameter window only the value 0.1ms may be set. At the
other values 0.35ms is internally used for input delay.

5-8
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Counter - Fast introduction

Overview

Pin assignment

Pin

TS0 o NeO M WN

N ) A A a A aAa a a
O O©W 0O NO O b WDN

The CPU 312-5BE13 has in-/outputs, which may be used for technological
functions respectively as standard periphery. Technological functions and
standard I/O may be used simultaneously with appropriate hardware.

Read access to inputs used by technological functions is possible. Write
access to used outputs is not possible.

The parameterization of the corresponding channel is made in the
hardware configurator by means of the Count submodule of the CPU 312C
from Siemens.

Now the following technological functions at 2 channels are at the disposal:
» Continuous count, e.g. for position decoding with Incremental encoder

» Single count, e.g. for unit decoding to a maximum limit

» Periodical count, e.g. for applications with repeated counting operations

Independent of the number of activated counters for the 312-5BE13 the
maximum frequency amounts to 10kHz.

The controlling of the appropriate modes of operation is made from the
user program by the SFB COUNT (SFB 47).

Assignment Pin Assignment

Power supply +DC 24V %% g&(vl" 0 21 Power supply +DC 24V
1+0.0 / Ch. 0 (A)/Pulse —08A | ey 22 Q+0.0 / Channel 0 Output
I1+0.1 / Ch. 0 (B)/Direction = '? = 23 Q+0.1 / Channel 1 Output
[+0.2 / Ch. 0 Hardware gate i 24 Q+0.2

[+0.3/ Ch. 1 (A)/ Pulse ] _32 25 Q+0.3

1+0.4 / Ch. 1 (B)/ Direction L4 26 Q+0.4

1+0.5 / Ch. 1 Hardware gate u 2 u 27 Q+0.5

1+0.6 = '7 = 28 Q+0.6

1+0.7 ikl 29 Q+0.7

not connected DR 30 Ground DO

not connected M 31 not connected

1+1.0 = zu 32 not connected

1+1.1 0 al 33 not connected

1+1.2 2] 34 not connected

[+1.3 L3l 35 not connected

I1+1.4 / Channel 0 Latch = 'g = 36 not connected

[+1.5/ Channel 1 Latch ] 6l 37 not connected

1+1.6 70 38 not connected

+1.7 5 Flic 39 not connected

Ground DI 40 not connected
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Preset respectively
parameterize
counter

Controlling the
counter functions

Controlling the
counter

The counter signal is detected and evaluated during counting operation.
Every counter occupies one double word in the input range for the counter
register. In the operating modes "single count" and "periodical count” an
end respectively start value may be defined according to the counting
direction up respectively down.

Each counter has parameterizable additional functions as gate function,
latch function, comparison value, hysteresis and hardware interrupt.

Each counter parameter may be set by the Count submodule of the
Siemens CPU 312C. Here is defined among others:

* Interrupt behavior

* max. Frequency

» Counter mode respectively behavior

» Stat, end, comparison value and hysteresis

The SFB COUNT (SFB 47) should cyclically be called (e.g. OB 1) for
controlling the counter functions. The SFB is to be called with the
corresponding instance DB. Here the parameters of the SFB are stored.

Among others the SFB 47 contains a request interface. Hereby you get
read and write access to the registers of the appropriate counter.

So that a new job may be executed, the previous job must have be finished
with JOB_DONE = TRUE. Per channel you may call the SFB in each case
with the same instance DB, since the data necessary for the internal
operational are stored here. Writing accesses to outputs of the instance DB
is not permissible.

Note!

You must not call an SFB you have configured in your program in another
program section under another priority class, because the SFB must not
interrupt itself.

Example: It is not allowed to call the same SFB both in OB 1 and in the
interrupt OB.

The counter is controlled by the internal gate (i gate). The i gate is the
result of logic operation of hardware gate (HW gate) and software gate
(SW gate), where the HW gate evaluation may be deactivated by the
parameterization.

HW gate: open (activate): Edge 0-1 at hardware gate, input of
the module
close (deactivate): Edge 1-0 at hardware gate, input of
the module
SW gate: open (activate): In application program by setting
SW_GATE of the SFB 47
close (deactivate): In application program by resetting

SW_GATE of the SFB 47

5-10
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Read counter

Counter inputs
(Connections)

Counter outputs

The counter values may be read by the output parameter COUNTVAL of
the SFB 47. There is also the possibility for direct access to the counter
values by means of the input address of the Count submodule.

There are the following possibilities for connection to the technological
functions:

» 24V incremental encoder, equipped with two tracks with 90° phase
offset

e 24V pulse generator with direction signal

» 24V proximity switch (e.g. BERO or light barrier)

For not all inputs are available at the same time, you may set the input
assignment for every counter via the parameterization. For each counter
the following inputs are available:

Channel, (A)

Pulse input for count signal res. track A of an encoder. Here you may
connect encoder with 1-, 2- or 4-tier evaluation.

Channel, (B)

Direction signal res. track B of the encoder. Via the parameterization you
may invert the direction signal.

Hardware gate,

This input allows you to open the HW gate with a high peek and thus start
a count process. The usage of the HW gate may be parameterized.

Latch,

With an edge 0-1 at Latch, the recent counter value is stored in a memory
that you may read at need.

Every counter has an assigned output channel. The following behavior for
the output channel may be set via parameterization:

* No comparison: Output is not controlled and is switched in the same
way as a normal output.

* Count value = comparison value:
Output is set as long as counter value = comparison value.

» Count value < comparison value:
Output is set as long as counter value < comparison value.

* Pulse at comparison value: You can specify a pulse period for
adaptation to the actuators you are using. The output is set for the given
pulse duration, as soon as the counter reached the comparison value. If
you have parameterized a main count direction the output is only set
when reaching the comparison value from the main counting direction.
The maximum pulse duration may amount to 510ms. By setting 0 as
pulse duration the output gets set as long as the comparison conditions
are fulfilled.
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Parameter
overview

General

Addresses

Basic parameters

In the following the parameters are listed which may be used for counter
configuration during hardware configuration.

Here the short description of the counter function may be found. At
Comment information about the module such as purpose may be entered.

Here the start address of the in- output periphery is set.

You have the following options:
» None: There is no interrupt triggered.

Here the interrupts the counter functions should trigger may be selected.

» Process: The counting function triggers a hardware interrupt.

» Diagnostics and Process: With the CPU 312-5BE13 the diagnostic
interrupt of the digital in-/output periphery is only supported in
connection with "hardware interrupt lost".

Count
Parameters Description Range of values Default
Main count * None: No restriction of the counting range * None None
direction « Up: Restricts the up-counting range. Counter starts |« Up
at 0 or load value, counts in positive direction up to |« Down
the declaration end value -1 and then jumps back (not with
to load value at the next positive transducer pulse. continuous
count)
* Down: Restricts the down-counting range. The
Counter starts at the declared start value or load
value in negative direction, counts to 1 and then
jumps to start value at the next negative encoder
pulse.
End value/ End value, with up-count as default. 2...2147483647 2147483647
Start value Start value, with down-count as default. (2*'-1) (2*'-1)
Gate function |+ Cancel count: The count starts when the gate |* Abort the count|Cancel count
opens and resumes at the load value when the operation

gate opens again.

e Stop count: The count is interrupted when the gate
closes and resumed at the last actual value when
the gate opens again.

* Interrupt the
count operation

Comparison The count value is compared with the comparison 0
value value. see also the parameter "Characteristics of the

output™:

¢ No main direction of count 2" to +2%'1

e Up-count as default 2°"to 3E1nd value-1

« Down-count as default 1to+27 -1
Hysteresis A hysteresis is used to eliminate frequent output jitter if | 0 to 255 0

the count value lies within the range of the comparison

value.

0 and 1 means: Hysteresis switched off
max. You can set the maximum frequency of the track |10, 5, 2, 1kHz 10kHz
frequency: Alpulse, track B/direction and hardware gate signals in
counting fixed steps.
signals/hard-
ware gate

continue ...
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... continued
Parameters Description Range of value Default
max. You can set the maximum frequency of the latch|10, 5, 2, 1kHz 10kHz
frequency: signal in fixed steps.
Latch
Signal The count and direction signals are connected to the Pulse/Direction | Pulse/Direction
evaluation input. Rotary encoder
A rotary transducer is connected to the input (single, single
dual or quadruple evaluation). Rotary encoder,
double
Rotary encoder
quadruple
Hardware In the activated state the Gate control is made via SW- activated deactivated
gate gate and HW-gate, otherwise via SW-gate only. deactivated
Count In the activated state the "direction" input signal is activated deactivated
direction inverted. deactivated
inverted
Characteristics | The output and the "Comparator" (STS_CMP) status No comparison | No comparison
of the output | bit are set, dependent on this parameter. Count =
comparison
value
Count <
comparison
value
Pulse at
comparison
value
Pulse duration | With the setting "Characteristics of the output: Pulse at | 0 to 510 0
comparison value" the pulse duration of the output
signal may be specified.
Only even values are possible. The value is internal
multiplied with 1.024ms.
Hardware In the activated state a hardware interrupt is generated activated
interrupt: when the hardware gate opens while the software gate deactivated
Hardware is open.
gate opening
Hardware In the activated state a hardware interrupt is generated activated deactivated
interrupt: when the hardware gate closes while the software deactivated
Hardware gate is open.
gate closing
Hardware In the activated state a hardware interrupt is triggered activated deactivated
interrupt: on reaching the comparator (reaction) value. deactivated
On reaching | The process interrupt may only be released if in
comparator addition the value of "Characteristics of the output” is
not "no comparison".
Hardware In the activated state a hardware interrupt is generated activated deactivated
interrupt: in the event of an overflow (exceeding the upper count deactivated
Overflow limit).
Hardware In the activated state a hardware interrupt is generated activated deactivated
interrupt: in the event of an underflow (undershooting the lower deactivated
Underflow count limit).

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12
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Counter - Controlling

Overview The controlling of the appropriate counter is made from the user program
by the SFB COUNT (SFB 47). The SFB is to be called with the
corresponding instance DB. Here the parameters of the SFB are stored.

With the SFB COUNT (SFB 47) you have following functional options:
» Start/Stop the counter via software gate SW_GATE

» Enable/control output DO

* Read the status bit

* Read the actual count and latch value

* Request to read/write internal counter registers

Parameter SFB 47

Name Decla- Data |Address |Default | Comment
ration type (Inst.-DB) |value
LADDR INPUT WORD 0.0 300h | This parameter is not evaluated. Always
the internal 1/O periphery is addressed.
CHANNEL | INPUT INT 2.0 0 Channel number

SW_GATE |INPUT BOOL 4.0 FALSE | Enables the Software gate

CTRL_DO INPUT BOOL 4.1 FALSE | Enables the output
False: Standard Digital Output

SET_DO INPUT BOOL 4.2 FALSE | Parameter is not evaluated
JOB_REQ INPUT BOOL 4.3 FALSE | Initiates the job (edge 0-1)
JOB_ID INPUT WORD 6.0 0 Job ID

JOB_ VAL INPUT DINT 8.0 0 Value for write jobs

STS_GATE |OUTPUT |BOOL 12.0 FALSE | Status of the internal gate

STS_STRT |OUTPUT |BOOL 12.1 FALSE | Status of the hardware gate (is only
refreshed if "HW gate" is activated in
hardware configuration before)

STS_LTCH |OUTPUT |BOOL 12.2 FALSE | Status of the latch input
STS DO OUTPUT |BOOL 12.3 FALSE | Status of the output

STS C DN |OUTPUT |BOOL 12.4 FALSE | Status of the down-count

Always indicates the last direction of
count. After the first SFB call STS_C_DN
is set FALSE.

STS C UP |OUTPUT |BOOL 12.5 FALSE | Status of the up-count
Always indicates the last direction of
count. After the first SFB call STS_C_UP

is set TRUE.
COUNTVAL DINT 14.0 0 Actual count value
LATCHVAL DINT 18.0 0 Actual latch value
JOB_DONE BOOL 22.0 TRUE |New job can be started.
JOB_ERR BOOL 221 FALSE | Job error
JOB_STAT WORD 24.0 0 Job error ID
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Local data only in

instance DB
Name Data type | Address Default Comment
(Instance DB) |value

RES00 BOOL 26.0 FALSE reserved

RESO1 BOOL 261 FALSE reserved

RES02 BOOL 26.2 FALSE reserved

STS_CMP |BOOL 26.3 FALSE Comparator Status
Status bit STS_CMP indicates that the
comparison condition of the comparator
is or was reached.
STS_CMP also indicates that the output
was set. (STS_DO = TRUE).
This parameter is only refreshed if in
the hardware configuration a compari-
son value is set at "Characteristics of
the output”.

RES04 BOOL 26.4 FALSE reserved

STS_OFLW |BOOL 26.5 FALSE Overflow status - is only set at range
overflow

STS_UFLW |BOOL 26.6 FALSE Underflow status - is only set at range
underflow "

STS_ZP BOOL 26.7 FALSE Status of the zero mark
The bit is only set when counting
without main direction.
Indicates the zero mark. This is also set
when the counter is set to 0 or if is start
counting.

JOB_OVAL |DINT 28.0 Output value for read request.

RES10 BOOL 32.0 FALSE reserved

RES11 BOOL 32.1 FALSE reserved

RES_STS BOOL 32.2 FALSE Reset status bits:

Resets the status bits: STS_CMP,
STS OFLW, STS ZP.

The SFB must be twice to reset the
status bit.

) Reset with RES_STS

Note!

Per channel you may call the SFB in each case with the same instance DB,
since the data necessary for the internal operational are stored here.
Writing accesses to outputs of the instance DB is not permissible.

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12
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Counter request

interface

Proceeding

To read/write counter registers the request interface of the SFB 47 may be
used.

So that a new job may be executed, the previous job must have be finished
with JOB_DONE = TRUE.

The deployment of the request interface takes place at the following
sequence:

» Edit the following input parameters:

Name Data Address | Default | Comment
type (DB)
JOB REQ |BOOL 4.3 FALSE | Initiates the job
(edges 0-1)
JOB_ID WORD 6.0 0 Job ID:

00h Job without function

01h Writes the count value

02h Writes the load value

04h Writes the comparison value
08h Writes the hysteresis

10h Writes the pulse duration
20h Writes the end value

82h Reads the load value

84h Reads the comparison value
88h Reads the hysteresis

90h Reads the pulse duration
AOh Reads the end value

JOB VAL |DINT 8.0 0 Value for write jobs

(see table at the following page)

* Call the SFB. The job is processed immediately. JOB_DONE only
applies to SFB run with the result FALSE. JOB_ERR = TRUE if an error
occurred. Details on the error cause are indicated at JOB_STAT.

Name Data Address | Default | Comment
type (DB)

JOB_DONE |BOOL 22.0 |TRUE |New job can be started

JOB_ERR |BOOL 22.1  |FALSE | Job error

JOB_STAT |[WORD 24.0 |0000h |Job error ID

0000h No error

0121h Compare value too low
0122h Compare value too high
0131h Hysteresis too low
0132h Hysteresis too high
0141h Pulse duration too low
0142h Pulse duration too high
0151h Load value too low
0152h Load value too high
0161h Count value too low
0162h Count value too high

01FFh Invalid job ID

* A new job may be started with JOB_DONE = TRUE.

* A value to be read of a read job may be found in JOB_OVAL in the
instance DB at address 28.
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Permitted value Continuous count:

range for Job

Valid range

JOB_VAL Writing counter directly

-2147483647 (-2°'+1) to +2147483646 (2°'-2)

Writing the load value

2147483647 (-2°'+1) to +2147483646 (2°'-2)

Writing comparison value

-2147483648 (-2°") to +2147483647 (2°'-1)

Writing hysteresis

0 to 255

Writing pulse duration®

0 to 510ms

Single/periodic count, no main count direction:

Job

Valid range

Writing counter directly

-2147483647 (-2°'+1) to +2147483646 (2°'-2)

Writing the load value

2147483647 (-2°'+1) to +2147483646 (2°'-2)

Writing comparison value

-2147483648 (-2°") to +2147483647 (2°'-1)

Writing hysteresis

0 to 255

Writing pulse duration®

0 to 510ms

Single/periodic count, main count direction up:

Job

Valid range

End value

2 to +2147483646 (2°'-1)

Writing counter directly

-2147483648 (-2°") to end value -2

Writing the load value

-2147483648 (-2°") to end value -2

Writing comparison value

-2147483648 (-2°") to end value -1

Writing hysteresis

0 to 255

Writing pulse duration*

0 to 510ms

Single/periodic count, main count direction down:

Job

Valid range

Writing counter directly

2 to +2147483647 (2°'-1)

Writing the load value

2 to +2147483647 (2°'-1)

Writing comparison value

1 to +2147483647 (2°'-1)

Writing hysteresis

0 to 255

Writing pulse duration*

0 to 510ms

*) Only even values allowed. Odd values are automatically rounded.

Latch function

As soon as during a count process an edge 0-1 is recognized at the

"Latch" input of a counter, the recent counter value is stored in the

according latch register.

You may access the latch register via LATCHVAL of the SFB 47.
A just in LATCHVAL loaded value remains after a STOP-RUN transition.

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12
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Counter - Functions

Parameterization

Load value,
End value

Main counting
direction

Start the Siemens SIMATIC Manager with your project and open the
hardware configurator.

* Place a profile rail.
» Configure at slot 2 the corresponding CPU from Siemens CPU 31xC.

* Open the dialog window "Properties" by a double click to the Count
submodule of the CPU.

* As soon as an operating mode to the corresponding channel is selected,
a dialog window for this operating mode is created and displayed and
filled with default parameters.

» Execute the wished parameterization.
» Store the project with Station > Save and compile.
» Transfer the project to the CPU.

Via the parameterization you have the opportunity to define a main
counting direction for every counter. If "none" or "endless" is chosen, the
complete counting range is available:

Limit counter Valid value range
Lower count limit -2 147 483 648 (-2°)
Upper count limit +2 147 483 647 (2°'-1)

Otherwise this range may be limited in both directions by a start value as
load value and an end value.

Main counting direction forward

Upper restriction of the count range. The counter counts 0 res. load value
in positive direction until the parameterized end value —1 and jumps then
back to the load value with the next following encoder pulse.

Please note a load value may exclusively be set by the request interface of
the counter.

Main counting direction backwards

Lower restriction of the count range. The counter counts from the
parameterized start- res. load value in negative direction to the
parameterized end value +1 and jumps then back to the start value with the
next following encoder pulse.

Please note an end value may exclusively be set by the request interface
of the counter.

5-18
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Count

In this operating mode, the counter counts from 0 res. from the load value.

Continuously When the counter counts forward and reaches the upper count limit and

another counting pulse in positive direction arrives, it jumps to the lower
count limit and counts from there on.
When the counter counts backwards and reaches the lower count limit and
another counting pulse in negative direction arrives, it jumps to the upper
count limit and counts from there on.

The count limits are set to the maximum count range.

Valid value range
Lower count limit |-2 147 483 648 (-2°")
Upper count limit | +2 147 483 647 (2°'-1)

counter value

upper
counter limit

A

load value t

0

lower
counter limit

7777777777777777777 overflow

ffffffffffffffffffffffffffffffffffffffffffffffffffffffffffff underflow

| | > time
gate start gate stop
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Count Once

No main counting direction

The counter counts once starting with the load value.
You may count forward or backwards.
The count limits are set to the maximum count range.

At over- or underrun at the count limits, the counter jumps to the
according other count limit and the gate is automatically closed.

To restart the count process, you must create an edge 0-1 of the gate.

At interrupting gate control, the count process continuous with the last
recent counter value.

At aborting gate control, the counter starts with the load value.

Valid value range

Lower count limit |-2 147 483 648 (-2°")

Upper count limit | +2 147 483 647 (2°'-1)

Interrupting gate control:
counter value

A | | |
Lpper ‘ : A overflow
counter limit [
|
|
1
load value | e
0 ,,,,,,,,,
lower b LN underflow
counter limit
| ‘ > time
gate start gate stop gate start gate stop
automatically automatically
Aborting gate control:
counter value
A |
upper S S
counter limit overflow
loadvalue —m—m—-------{\-----"-Sf - H -\
0 ,,,,,,,,,
lower P e ittt St underflow
counter limit ! | ‘ ‘
! \ | \ > time
gate start gate stop gate start gate stop
automatically automatically
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Main counting direction forward
» The counter counts starting with the load value.

» When the counter reaches the end value —1 in positive direction, it
jumps to the load value at the next positive count pulse and the gate is
automatically closed.

» To restart the count process, you must create an edge 0-1 of the gate.
The counter starts with the load value.

Valid value range
Limit value -2 147 483 647 (-2°"+1) to +2 147 483 647 (2°'-1)
Lower count limit |-2 147 483 648 (-2°")

counter value

A | | |
| | |
endvalue ---- | overflow
|
|
|
|
|
|
load value ‘
| | |
0 Fr-=--- l I I
| | |
| | |
| | |
| | |
| | |
| | |
| | |
| | |
|0Wer ,,,,,,,,,,,,,,,,,,,,,,,J ,,,,, L [ underﬂow
counter limit ! | |
} ‘ ‘ " time
gate start gate stop gate start gate stop
automatically automatically

Main counting direction backwards
* The counter counts backwards starting with the load value.

* When the counter reaches the end value +1 in negative direction, it
jumps to the load value at the next negative count pulse and the gate is
automatically closed.

» To restart the count process, you must create an edge 0-1 of the gate.
The counter starts with the load value.

Valid value range

Limit value -2 147 483 648 (-2°") to +2 147 483 646 (2°'-2)

Upper count limit | +2 147 483 647 (2°'-1)

counter value
A
upper

counter limit

load value |

|
|
.
|
|
|
1
|

endvalue -----

[0 [ S ——

|
gate start gate stop gate start gate stop
automatically automatically
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Count No main counting direction
Periodically « The counter counts forward or backwards starting with the load value.

* At over- or underrun at the count limits, the counter jumps to the
according other count limit and counts from there on.

* The count limits are set to the maximum count range.

Valid value range
Lower count limit |-2 147 483 648 (-2°")
Upper count limit | +2 147 483 647 (2°'-1)

counter value

A [ |
! |
upper
b imi ! ‘ overflow
counter limit I I
! |
! |
! |
! |
! |
! |
! |
J |
loadvalue ———~~----4---/----F--\----—4 K ,,,,,,,,,, [
! |
0 ‘ ‘ zero-crossing
! |
! |
! |
! |
! |
! |
! |
|
! |
lower ‘ |
N S i P underflow
counter limit | |
! |
! |

: : > time
gate start gate stop

Main counting direction forward
» The counter counts forward starting with the load value.

* When the counter reaches the end value -1 in positive direction, it jumps
to the load value at the next positive count pulse.

Valid value range
Limit value -2 147 483 647 (-2°"+1) to +2 147 483 647 (2°'-1)
Lower count limit |-2 147 483 648 (-2°")

counter value

A |
|
end value A ! overflow
|
|
|
|
|
|
|
|
|
|
|
|
|
! |
load value !
|
|
0 4‘ |
| |
|
|
|
|
|
|
|
|
|
|
|
|
|
|
|
! |
lower :
T e ——__——————————————.-..  iib e underflow
counter limit ‘ :
| ! " time

gate start gaté stop
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Main counting direction backwards
» The counter counts backwards starting with the load value.

 When the counter reaches the end value +1 in negative direction, it
jumps to the load value at the next negative count pulse.

* You may exceed the upper count limit.

Valid value range

Limit value

-2 147 483 648 (-2°") to +2 147 483 646 (2°'-2)

Upper count limit

+2 147 483 647 (2°'-1)

counter value

upper
counter limit

load value |

end value

0

4

A

gate start

gate stop

" time
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Counter - Additional functions

Overview

Schematic structure

HW gate

The following additional functions may be set via the parameterization for
every counter:

Gate function
The gate function serves the start, stop and interrupt of a count function.
Latch function

An edge 0-1 at the digital input "Latch" stores the recent counter value
in the latch register.

Comparison

You may set a comparison value that activates res. de-activates a digital
output res. releases a hardware interrupt depending on the counter
value.

Hysteresis

The setting of a hysteresis avoids for example a high output toggling
when the value of an encoder signal shifts around a comparison value.

The illustration shows how the additional functions influence the counting
behavior. The following pages describe these functions in detail:

SW gate Pulse/Track A Direction/Track B Latch

Internal gate >
Pulse evaluation e

R

Load value T

¢ e » | Process
Comparison value Counter value Latch 2 alarm
| | e

Comparision

Hysteresis

v

Output
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Gate function The counter is controlled by the internal gate (i gate). The i gate is the
result of logic operation of hardware gate (HW gate) and software gate
(SW gate), where the HW gate evaluation may be deactivated by the
parameterization.

HW gate: open (activate): Edge 0-1 at hardware gate, input of
the module
close (deactivate): Edge 1-0 at hardware gate, input of
the module
SW gate: open (activate): In application program by setting
SW_GATE of the SFB 47
close (deactivate): In application program by resetting

SW_GATE of the SFB 47

Gate function cancel and stop

The parameterization defines if the gate cancels or stops the counter
process.

» At cancel function the counter starts counting with the load value after
gate restart.

counter value
A

load value |

j j j > time
gate start gate stopp gate start

» At stop function, the counter continues counting with the last recent
counter value after gate restart.

counter value
A

load value | e T T I

» time

| I
gate start gate stopp gate start
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Gate control
abort,
interruption

Gate control
"Count once"

Latch function

How the CPU should react at opening of the SW gate may be set with the
parameter Gate function. The usage of the HW gate may be determined by

the parameter Hardware gate.

Gate control via SW gate, canceling

(HW gate deactivated, gate function: Cancel count)

SW gate

HW gate

Reaction Counter

edge 0-1

de-activated

Restart with load value

Gate control via SW gate, stopping

(HW gate deactivated, gate function: Stop count)

SW gate

HW gate

Reaction Counter

edge 0-1

de-activated

Continue

Gate control via SW/HW gate, canceling

(HW gate activated, gate function: Cancel count)

SW gate HW gate Reaction Counter
edge 0-1 1 Continue
1 edge 0-1 Restart with load value

Gate control via SW/HW gate, stopping

(HW gate activated, gate function: Stop count)

SW gate HW gate Reaction Counter
edge 0-1 1 Continue
1 edge 0-1 Continue

Gate control via SW/HW gate, operating mode "Count once"

If the internal gate has been closed automatically it may only be opened
again under the following conditions:

SW gate HW gate Reaction | gate
1 edge 0-1 1
edge 0-1 edge 0-1 1
(after edge 0-1 at HW
gate)

As soon as during a count process an edge 0-1 is recognized at the
"Latch" input of a counter, the recent counter value is stored in the
according latch register.

The latch value may be accessed by the parameter LATCHVAL of the

SFB 47.

A just in LATCHVAL loaded value remains after a STOP-RUN transition.
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Comparator

Characteristics of
the output

In the CPU a comparison value may be stored that is assigned to the digital
output, to the status bit "Status Comparator" STS CMP and to the
hardware interrupt. The digital output may be activated depending on the
count value and comparison value. A comparison value may be entered by
the parameter assignment screen form respectively by the request
interface of the SFB 47.

You pre-define the behavior of the counter output via the parameterization:
» output never switches

» output switch when counter value = comparison value

» output switch when counter value < comparison value

» output switch at comparison value

No comparison

The output is set as normal output. The SFB input parameter CTRL_DO is
effect less. The status bits STS_DO and STS_CMP (Status comparator in
the instance DB) remain reset.

Count =comparison value respectively Count < comparison value

The output remains set as long as the counter value is higher or equal
comparison value respectively lower or equal comparison value. For this
the control bit must be set.

The comparison result is shown by the status bit STS_CMP.

This status bit may only be reset if the comparison condition is no longer
fulfilled.

Pulse at comparison value

When the counter reaches the comparison value the output is set for the
parameterized pulse duration. If you have configured a main count
direction the output is only activated when the comparison value is reached
with the specified main count direction. For this the control bit CTRL_DO
should be set first.

The status of the digital output may be shown by the status bit ST_DO.

The comparison result is shown by the status bit STS_CMP. This status bit
may only be reset if the pulse duration has run off. comparison condition is
no longer fulfilled.

With pulse time = 0 the output is as set as the comparison condition is
fulfilled.

Pulse duration

For adaptation to the used actors a pulse duration may be specified. The
pulse duration defines how long the output should be set. It may be preset
in steps of 2ms between 0 and 510ms. The pulse duration starts with the
setting of the according digital output. The inaccuracy of the pulse duration
is less than 1ms.

There is no past triggering of the pulse duration when the comparison
value has been left and reached again during pulse output. A change of the
pulse period during runtime is not applied until the next pulse.
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Hysteresis

The hysteresis serves e.g. the avoidance of many toggle processes of the
output and the interrupt, if the counter value is in the range of the
comparison value. You may set a range of 0 to 255. The settings 0 and 1
deactivate the hysteresis. The hysteresis influences the zero run, over- and
underflow.

An activated hysteresis remains active after a change. The new hysteresis
range is taken over at the next reach of the comparison value.

The following pictures illustrate the output behavior for hysteresis 0 and
hysteresis 3 for the according conditions:

Effect at counter value =comparison value

Counter value
8 \ JJ
7 | Hysteresis I—l ’_l% \_L‘ ’_IJ%
Comparison value g P [ ] ] ®\ /@ @\
Ay e iy
: T
0

Output:
Hysteresis = 0

Hysteresis = 3

CSNCNGNCRCNCNGC)

Counter value = comparison value - output is set and hysteresis activated
Leave hysteresis range - output is reset

Counter value = comparison value - output is set and hysteresis activated
Leave hysteresis range, output remains set for counter value = comparison value
Counter value < comparison value and hysteresis active — output is reset
Counter value = comparison value — output is not set for hysteresis active

Leave hysteresis range, output remains set for counter value = comparison value

With reaching the comparison condition the hysteresis gets active. At
active hysteresis the comparison result remains unchanged until the
counter value leaves the set hysteresis range. After leaving the hysteresis
range a new hysteresis is only activated with again reaching the
comparison conditions.
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Effect at pulse at comparison value with pulse duration Zero

Counter value
1

8 I

7 | Hysteresis |_| I—'((
Comparison valueg P [ ] ®\ ’JJ\® \—L‘;@ @\

4 L]

Il Ay T

_ T I

oo

Output: _| [ _| B _| ] _|
Hysteresis = 0

Hysteresis = 3

Counter value = comparison value - output is set and hysteresis activated

Leave hysteresis range — output is reset and counter value < comparison value
Counter value = comparison value - output is set and hysteresis activated
Output is reset for leaving hysteresis range and counter value > comparison value
Counter value = comparison value - output is set and hysteresis activated
Counter value = comparison value and hysteresis active — output remains set

SECKSRCASRCEC)

Leave hysteresis range and counter value > comparison value - output is reset

With reaching the comparison condition the hysteresis gets active. At
active hysteresis the comparison result remains unchanged until the
counter value leaves the set hysteresis range. After leaving the hysteresis
range a new hysteresis is only activated with again reaching the
comparison conditions.
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Effect at pulse at comparison value with pulse duration not zero
Counter value

1
8 1
7 | Hysteresis I—l
Comparison valueg y P [ 1] . ®\ ’_IJ% LI—‘Q @\ ’_IJ%
A e I ally
a_ T T
o<

Output: _| ] _| ] _| ] _|
Hysteresis = 0
Hysteresis = 3 |

Counter value = comparison value - pulse of the parameterized duration is put out, the
hysteresis is activated and the counting direction stored

Leaving the hysteresis range contrary to the stored counting direction - pulse of the
parameterized duration is put out, the hysteresis is de-activated

Counter value = comparison value - pulse of the parameterized duration is put out, the
hysteresis is activated and the counting direction stored

Leaving the hysteresis range without changing counting direction - hysteresis is de-activated

Counter value = comparison value - pulse of the parameterized duration is put out, the
hysteresis is activated and the counting direction stored

Counter value = comparison value and hysteresis active - no pulse

0O O ® © ©

Leaving the hysteresis range contrary to the stored counting direction - pulse of the
parameterized duration is put out, the hysteresis is de-activated

With reaching the comparison condition the hysteresis gets active and a
pulse of the parameterized duration is put out. As long as the counter value
is within the hysteresis range, no other pulse is put out. With activating the
hysteresis the counting direction is stored in the CPU. If the counter value
leaves the hysteresis range contrary to the stored counting direction, a
pulse of the parameterized duration is put out. Leaving the hysteresis
range without direction change, no pulse is put out.
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Counter - Diagnostic and interrupt

Overview

Hardware interrupt

Local double word 8

of the OB 40

The parameterization allows you to define the following trigger for a
hardware interrupt that may initialize a diagnostic interrupt:

Status changes at an input (at opened SW gate)
Status changes at the HW-gate (at opened SW gate)
Reaching a comparison value

Overflow respectively at overrun upper counter limit
Underflow respectively at underrun lower counter limit

A hardware interrupt causes a call of the OB 40. Within the OB 40 you may
find the logical basic address of the module that initialized the hardware
interrupt by using the Local word 6. More detailed information about the
initializing event is to find in the local double word 8.

The local double word 8 of the OB 40 has the following structure:

Local byte |[Bit7 ...Bit0

8 Bit 0: Edge at 1+0.0
Bit 1: Edge at 1+0.1
Bit 2: Edge at |1+0.2
Bit 3: Edge at 1+0.3
Bit 4: Edge at 1+0.4
Bit 5: Edge at 1+0.5
Bit 6: Edge at 1+0.6
Bit 7: Edge at 1+0.7

9 Bit 0: Edge at 1+1.0
Bit 1: Edge at 1+1.1
Bit 2: Edge at 1+1.2
Bit 7 ... 3: reserved

10 Bit 0: Gate counter 0 open (activated)

Bit 1: Gate counter 0 closed

Bit 2: Over-/underflow/end value counter 0
Bit 3: Counter 0 reached comparison value
Bit 4: Gate counter 1 open (activated)

Bit 5: Gate counter 1 closed

Bit 6: Over-/underflow/ end value counter 1
Bit 7: Counter 1 reached comparison value

11 Bit 7 ... O: reserved
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Diagnostic Via the parameterization (record set 7Fh) you may activate a global
interrupt diagnostic interrupt for the analog and digital part.

A diagnostic interrupt occurs when during a hardware interrupt execution in
OB 40 another hardware interrupt is thrown for the same event. The
initialization of a diagnostic interrupt interrupts the recent hardware interrupt
execution in OB 40 and branches in OB 82 to diagnostic interrupt
processingincoming. If during the diagnostic interrupt processing other events
are occurring at other channels that may also cause a process res.
diagnostic interrupt, these are interim stored.

After the end of the diagnostic interrupt processing at first all interim-stored
diagnostic interrupts are processed in the sequence of their occurrence
and then all hardware interrupts.

If a channel where currently a diagnostic interruptincoming iS processed res.
interim stored initializes further hardware interrupts, these get lost. When a
hardware interrupt for which a diagnostic interruptincoming has been released
is ready, the diagnostic interrupt processing is called again as diagnostic
interruptgoing.

All events of a channel between diagnostic interruptiscoming @nd dlagnostlc
interruptging are not stored and get lost. Within this time window (1S
diagnostic interruptincoming UNtil last diagnostic interruptyeng) the SF-LED of
the CPU is on. Additionally for every diagnostic interruptincomingigoing @n entry
in the diagnostic buffer of the CPU occurs.

Example
Input channel:  [8] 18]
Process alarm:
| | | | |
without Diagnostic alarm: OB40: | 0B40_8 \ 0B40_3 | 0B40 6 0B40_14 0B40_3
(8] Iost 6
Fast memory buffer (FIFO): 3 ﬂ 6] 14 14
3
with Diagnostic alarm: OB40: | 0oB40_8 ¢°B4°—3 0B406 foB40_14
OB82: v0882 8‘ \ ossg 3 i GBs2 g OB82_3
incoming incoming outgoing outgoing
8 E lost
Fast memory buffer Proz (FIFO): 6] 14|
6]
8
Fast memory buffer Diag (FIFO): 8] 3]3] El
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Diagnostic interrupt  Every OB 82 call causes an entry in the diagnostic buffer of the CPU

processing containing

error cause and module address.

By using the SFC 59 you may read the diagnostic bytes.
At de-activated diagnostic interrupt you have access to the last recent

diagnostic

event.

If you've activated the diagnostic function in your hardware configuration,
the contents of record set 0 are already in the local double word 8 when
calling the OB 82. The SFC 59 allows you to also read the record set 1 that
contains additional information.

After leaving the OB 82 a clear assignment of the data to the last

diagnostic

The record sets of the diagnostic range have the following structure:

interrupt is not longer possible.

Record set 0 Byte

Bit7 ... Bit 0

DiagnostiCincoming 0

Bit 0: set at module failure

Bit 1: 0 (fix)

Bit 2: set at external error

Bit 3: set at channel error

Bit 4: set when external auxiliary supply is missing
Bit 7 ... 5: 0 (fix)

Bit 3 ... 0: Module class

0101b: Analog

1111b: Digital
Bit 4: Channel information present
Bit 7 ... 5: 0 (fix)

Bit 3 ... 0: O (fix)

Bit 4: Failure module internal supply voltage
(output overload)

Bit 7 ... 5: 0 (fix)

Bit 5 ... 0: O (fix)
Bit 6: Hardware interrupt lost
Bit 7: 0 (fix)

Record set 0 After the
DiagnostiCgging diagnostic

removing error a diagnostic messageg.ing takes place if the

interrupt release is still active.

Byte

Bit7...Bit0

0

Bit 0: set at module failure

Bit 1: 0 (fix)

Bit 2: set at external error

Bit 3: set at channel error

Bit 4. set when external auxiliary supply is missing
Bit 7 ... 5: 0 (fix)

Bit 3 ... 0: Module class
0101b: Analog module
1111b: Digital
Bit 4: Channel information present
Bit 7 ... 5: 0 (fix)

WIN

00h (fix)
00h (fix)
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Diagnostic
Record set 1
(Byte 0 ... 15)

The record set 1 contains the 4Byte of the record set 0 and additionally
12Byte module specific diagnostic data.

The diagnostic bytes have the following assignment:

Byte

Bit7...Bit0

0..3

Contents record set 0 (see page before)

4

Bit 6 ... 0: channel type (here 70h)
70h: Digital input
71h: Analog input
72h: Digital output
73h: Analog output
74h: Analog in-/output
Bit 7: More channel types present
0: no
1: yes

Number of diagnostic bits per channel (here 08h)

Number of channels of a module (here 08h)

N[O

Bit 0: Error in channel group 0 (1+0.0 ... 1+0.3)
Bit 1: Error in channel group 1 (1+0.4 ... 1+0.7)
Bit 2: Error in channel group 2 (1+1.0 ... 1+1.3)
Bit 3: Error in channel group 3 (1+1.4 ... I+1.7)
Bit 4: Error in channel group 4 (Counter 0)

Bit 5: Error in channel group 5 (Counter 1)

Bit 6: reserved

Bit 7: reserved

Diagnostic interrupt due to hardware interrupt lost at...

Bit 0: ... input [+0.0
Bit 1: 0 (fix)
Bit 2: ... input 1+0.1
Bit 3: 0 (fix)
Bit 4. ... input [+0.2
Bit 5: 0 (fix)
Bit 6: ... input 1+0.3
Bit 7: 0 (fix)

Diagnostic interrupt due to hardware interrupt lost at...

Bit 0: ... input 1+0.4
Bit 1: 0 (fix)
Bit 2: ... input 1+0.5
Bit 3: 0 (fix)
Bit 4: ... input 1+0.6
Bit 5: 0 (fix)
Bit 6: ... input 1+0.7
Bit 7: 0 (fix)

10

Diagnostic interrupt due to hardware interrupt lost at...

Bit 0: ... input [+1.0
Bit 1: 0 (fix)
Bit 2: ... input 1+1.1
Bit 3: 0 (fix)
Bit 4. ... input [+1.2
Bit 5: 0 (fix)
Bit 7 ... 6: reserved

continued ...
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... continue Record set 1

Byte Bit7 ...Bit0
11 Bit 7 ... O: reserved
12 Diagnostic interrupt due to hardware interrupt lost at...
Bit 0: ... Gate Counter O closed
Bit 1: 0 (fix)
Bit 2: ... Gate Counter 0 open
Bit 3: 0 (fix)
Bit 4: ... Over-/underflow/end value Counter 0
Bit 5: 0 (fix)
Bit 6: ... Counter 0 reached comparison value
Bit 7: 0 (fix)
13 Diagnostic interrupt due to hardware interrupt lost at...
Bit 0: ... Gate Counter 1 closed
Bit 1: 0 (fix)
Bit 2: ... Gate Counter 1 open
Bit 3: 0 (fix)
Bit 4: ... Over-/underflow/end value Counter 1
Bit 5: 0 (fix)
Bit 6: ... Counter 1 reached comparison value
Bit 7: 0 (fix)
14 reserved
15 reserved
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Chapter 6

Overview

Content

Deployment PtP communication

Content of this chapter is the deployment of the RS485 slot for serial PtP
communication.

Here you'll find all information about the protocols and project engineering
of the interface, which are necessary for the serial communication using
the RS485 interface.

Topic Page
Chapter 6  Deployment PtP communication ..........cccceeeeeevvriiiiinnnnnn. 6-1
Fast introduction...........ooooiiiii i 6-2
Principals of the data transfer.............ccccoiiiiiiiiiiie 6-3
Deployment RS485 interface............coovvviiiiiiiiiiiiiieeceee e 6-4
Parameterization .............o.o oo 6-5
COMMUNICALION ... e 6-8
Protocols and proCcedures ...........ooooiiiiiiiiiiiie e 6-14
Modbus - FUNCHION COAES ......ccoeieiiiiiieiee e 6-18
Modbus - Example communication.............cccooiviiiiiiiiiciiiie e 6-22
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Fast introduction

General

Protocols

Parameterization

Communication

Overview SFCs
for serial
communication

The CPU 312-5BE13 has a RS485 interface X3, which is fix set to PtP
communication (point-to-point). This supports the serial process connection
to different source or destination systems.

The protocols res. procedures ASCII, STX/ETX, 3964R, USS and Modbus
are supported.

The parameterization happens during runtime using the SFC 216
(SER_CFG). For this you have to store the parameters in a DB for all
protocols except ASCII.

The communication is controlled by SFCs. Send takes place via SFC 217
(SER_SND) and receive via SFC 218 (SER_RCV).

The repeated call of the SFC 217 SER_SND delivers a return value for
3964R, USS and Modbus via RetVal that contains, among other things,
recent information about the acknowledgement of the partner station.

The protocols USS and Modbus allow to evaluate the receipt telegram by
calling the SFC 218 SER_RCV after SER_SND.

The SFCs are included in the consignment of the CPU.

The following SFCs are used for the serial communication:

SFC Description
SFC 216 SER _CFG RS485 parameterize
SFC 217 SER_SND RS485 send
SFC 218 SER _RCV RS485 receive

6-2
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Principals of the data transfer

Overview

Principle

The data transfer is handled during runtime by using SFCs. The principles
of data transfer are the same for all protocols and is shortly illustrated in
the following.

Data that is into the according data channel by the PLC, is stored in a FIFO
send buffer (first in first out) with a size of 2x1024Byte and then put out via
the interface.

When the interface receives data, this is stored in a FIFO receive buffer
with a size of 2x1024Byte and can there be read by the PLC.

If the data is transferred via a protocol, the adoption of the data to the
according protocol happens automatically.

In opposite to ASCIlI and STX/ETX, the protocols 3964R, USS and Modbus
require the acknowledgement of the partner.

An additional call of the SFC 217 SER_SND causes a return value in
RetVal that includes among others recent information about the
acknowledgement of the partner.

Further on for USS and Modbus after a SER_SND the acknowledgement
telegram must be evaluated by call of the SFC 218 SER_RCV.

RS485 PtP communication

Program

SER_RCV
SFC 218

SER_CFG
SFC 216

SER_SND
SFC 217

Protocol FIFO Buffer Interface
IN RS485
«— A 1024Byte
1024Byte| ¢——
CFG ouT A

A 1024Byte| ——

— | | 1024Byte
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Deployment RS485 interface

Overview

Properties
RS485

Connection RS485

Connection

The RS485 interface from the CPU is fix set to PtP communication.
Parameterization and communication happens by means of SFCs.

The following characteristics distinguish the RS485 interface:

» Logical states represented by voltage differences between the two cores
of a twisted pair cable

» Serial bus connection in two-wire technology using half duplex mode

» Data communications up to a max. distance of 500m

» Data communication rate up to 115.2kBaud

9pin SubD jack

Pin RS485

1 n.c.

2 M24V

3 RxD/TxD-P (Line B)

4 RTS

5 M5V

6 P5V

7 P24V

8 RxD/TxD-N (Line A)

9 n.c.

CPU - RS485 Periphery
RxD/TxD-P (B) 3 RxD/TxD-P (B)
RxD/TxD-N (A) 8 RxD/TxD-N (A)
shield

) Periphery
J_ RxD/TxD-P (B)
RxD/TxD-N (A)
|
: . i
Periphery
RxD/TxD-P (B)
RxD/TxD-N (A)
1

6-4
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Parameterization

SFC 216 The parameterization happens during runtime deploying the SFC 216
(SER_CFG) (SER_CFG). You have to store the parameters for STX/ETX, 3964R, USS
and Modbus in a DB.
Name Declaration | Type Comment
Protocol IN BYTE 1=ASCII, 2=STX/ETX, 3=3964R
Parameter IN ANY Pointer to protocol-parameters
Baudrate IN BYTE Number of the baudrate
CharLen IN BYTE 0=5Bit, 1=6Bit, 2=7Bit, 3=8Bit
Parity IN BYTE 0=None, 1=0dd, 2=Even
StopBits IN BYTE 1=1Bit, 2=1.5Bit, 3=2Bit
FlowControl |IN BYTE 1 (fix)
RetVal ouT WORD Return value (0 = OK)
Parameter All time settings for timeouts must be set as hexadecimal value. Find the
description hex value by multiply the wanted time in seconds with the baudrate.
Example: Wanted time 8ms at a baudrate of 19200Baud
Calculation: 19200Bit/s x 0,008s = 154Bit - (9Ah)
Hex value is 9Ah.
Protocol Here you fix the protocol to be used. You may choose between:

1: ASCII

2: STX/ETX

3: 3964R

4: USS Master

5: Modbus RTU Master
6: Modbus ASCII Master
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Parameter (as DB)

Baud rate

CharlLen

At ASCII protocol, this parameter is ignored.

At STX/ETX, 3964R, USS and Modbus you fix here a DB that contains the
communication parameters and has the following structure for the
according protocols:

Data block at STX/ETX

DBBO0O: STX1 BYTE (1. Start-ID in hexadecimal)
DBB1: STX2 BYTE (2. Start-ID in hexadecimal)
DBB2: ETX1 BYTE (1. End-ID in hexadecimal)
DBB3: ETX2 BYTE (2. End-ID in hexadecimal)
DBW4: TIMEOUT WORD (max. delay time between 2 telegrams)

Note!

The start res. end sign should always be a value <20, otherwise the sign is
ignored!

Data block at 3964R

DBBO0: Prio BYTE (The priority of both partners must be
different)

DBB1: ConnAttmptNr BYTE (Number of connection trials)
DBB2: SendAttmptNr BYTE (Number of telegram retries)
DBW4: CharTimeout WORD (Character delay time)
DBW6: ConfTimeout WORD (Acknowledgement delay time)

Data block at USS
DBWO: Timeout WORD (Delay time in)

Data block at Modbus-Master
DBWO: Timeout WORD (Respond delay time)

Velocity of data transfer in Bit/s (Baud).

04h: 1200Baud  05h: 1800Baud 06h: 2400Baud 07h: 4800Baud
08h: 7200Baud  09h: 9600Baud O0Ah: 14400Baud O0Bh: 19200Baud
0Ch: 38400Baud 0Dh: 57600Baud OEh: 115200Baud

Number of data bits where a character is mapped to.
0: 5Bit 1:6Bit 2:7Bit  3: 8Bit

6-6
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Parity

StopBits

FlowControl

RetVal SFC 216
(Error message
SER_CFG)

The parity is -depending on the value- even or odd. For parity control, the
information bits are extended with the parity bit, that amends via its value
("0" or "1") the value of all bits to a defined status. If no parity is set, the
parity bit is set to "1", but not evaluated.

0: NONE 1:0DD 2: EVEN

The stop bits are set at the end of each transferred character and mark the
end of a character.

1: 1Bit 2:1.5Bit  3: 2Bit

The parameter FlowControl is ignored. When sending RTS=1, when
receiving RTS=0.

Return values send by the block:

Error code |Description

0000h no error

809Ah interface not found or used for PROFIBUS
8x24h Error at SFC-Parameter x, with x:

Error at "Protocol"

Error at "Parameter”

Error at "Baudrate"

Error at "CharLength"

Error at "Parity"

Error at "StopBits"

: Error at "FlowControl" (Parameter missing)
809xh Error in SFC parameter value x, where x:
Error at "Protocol"

Error at "Baudrate"

Error at "CharLength"

Error at "Parity"

Error at "StopBits"

Error at "FlowControl"

8092h Access error in parameter DB (DB too short)
828xh Error in parameter x of DB parameter, where x:
1: Error 1. parameter

2: Error 2. parameter

Nk w2

No g how
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Communication

Overview The communication happens via the send and receive blocks SFC 217
(SER_SND) and SFC 218 (SER_RCV).

The SFCs are included in the consignment of the CPU.

SFC 217 This block sends data via the serial interface.

(SER_SND) The repeated call of the SFC 217 SER_SND delivers a return value for
3964R, USS and Modbus via RetVal that contains, among other things,
recent information about the acknowledgement of the partner station.

The protocols USS and Modbus require to evaluate the receipt telegram by
calling the SFC 218 SER_RCV after SER_SND.

Parameter

Name Declaration | Type Comment

DataPtr IN ANY Pointer to Data Buffer for sending data

DataLen ouT WORD Length of data sent

RetVal ouT WORD Return value (0 = OK)

DataPtr Here you define a range of the type Pointer for the send buffer where the
data that has to be sent is stored. You have to set type, start and length.
Example: Data is stored in DB5 starting at 0.0 with a length of

124Byte.
DataPtr:=P#DB5.DBX0.0 BYTE 124

DatalLen Word where the number of the sent Bytes is stored.
At ASCII if data were sent by means of SFC 217 faster to the serial
interface than the interface sends, the length of data to send could differ
from the DatalLen due to a buffer overflow. This should be considered by
the user program.
With STX/ETX, 3964R, Modbus and USS always the length set in DataPtr
is stored or O.
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RetVal SFC 217 Return values of the block:
(Error message
SER_SND) Error code |Description

0000h Send data - ready

1000h Nothing sent (data length 0)

20xxh Protocol executed error free with xx bit pattern for
diagnosis

7001h Data is stored in internal buffer - active (busy)
7002h Transfer - active

80xxh Protocol executed with errors with xx bit pattern for
diagnosis (no acknowledgement by partner)

90xxh Protocol not executed with xx bit pattern for diagnosis (no
acknowledgement by partner)

8x24h Error in SFC parameter x, where x:

1: Error in "DataPtr"

2: Error in "DataLen"

8122h Error in parameter "DataPtr" (e.g. DB too short)

807Fh Internal error

809Ah Interface not found or interface is used for PROFIBUS
809Bh Interface not configured

Protocol specific ASCII
RetVal values Value Description

9000h Buffer overflow (no data send)
9002h Data too short (OByte)

STX/ETX

Value Description

9000h Buffer overflow (no data send)
9001h Data too long (>1024Byte)
9002h Data too short (OByte)

9004h Character not allowed

3964R
Value Description

2000h Send ready without error
80FFh NAK received - error in communication

80FEh Data transfer without acknowledgement of partner or error
at acknowledgement

9000h Buffer overflow (no data send)
9001h Data too long (>1024Byte)
9002h Data too short (OByte)
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... Continue USS
RetVal SFC 217 Error code | Description
SER_SND 2000h | Send ready without error
8080h Receive buffer overflow (no space for receipt)

8090h Acknowledgement delay time exceeded
80FO0Oh Wrong checksum in respond

80FEh Wrong start sign in respond

80FFh Wrong slave address in respond

9000h Buffer overflow (no data send)

9001h Data too long (>1024Byte)

9002h Data too short (<2Byte)

Modbus RTU/ASCII Master
Error code |Description
2000h Send ready (positive slave respond)
2001h Send ready (negative slave respond)
8080h Receive buffer overflow (no space for receipt)
8090h Acknowledgement delay time exceeded
80FO0Oh Wrong checksum in respond
80FDh Length of respond too long
80FEh Wrong function code in respond
80FFh Wrong slave address in respond
9000h Buffer overflow (no data send)
9001h Data too long (>1024Byte)
9002h Data too short (<2Byte)
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Principles of The following text shortly illustrates the structure of programming a send
programming command for the different protocols.
3964R USS / Modbus

SFC 217
SER_SND

SFC 217
SER_SND

N

N

RetVal 8xah | etVal 8xxxh J
90xxh ? v 90xxh ?
N

N

SFC 218
SER_RCV

Error evaluation

Error evaluation

Retval 2001h ? >J—— RetVal 2001h ? >J
N N

SFC 218
RetVal 2000h 2> RetVal 2000h ? 2J SER_RCV
N l

N
Data evaluation Data evaluation

ASCII / STXIETX

SFC 217
SER_SND

RetVal 900xh J
NL Error evaluation
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SFC 218 This block receives data via the serial interface.

(SER_RCV) Using the SFC 218 SER_RCYV after SER_SND with the protocols USS and
Modbus the acknowledgement telegram can be read.

Parameter

Name Declaration | Type Comment

DataPtr IN ANY Pointer to Data Buffer for received data

DataLen ouT WORD Length of received data

Error ouT WORD Error Number

RetVal ouT WORD Return value (0 = OK)

DataPtr Here you set a range of the type Pointer for the receive buffer where the
reception data is stored. You have to set type, start and length.
Example: Data is stored in DB5 starting at 0.0 with a length of 124Byte.

DataPtr:=P#DB5.DBX0.0 BYTE 124

DatalLen Word where the number of received Bytes is stored.
At STX/ETX and 3964R, the length of the received user data or O is
entered.
At ASCII, the number of read characters is entered. This value may be
different from the read telegram length.

Error This word gets an entry in case of an error. The following error messages
may be created depending on the protocol:
ASCII
Bit | Error Description

0 |overrun Overflow, a sign couldn’t be read fast enough from the
interface

1 |framing error |Error that shows that a defined bit frame is not
coincident, exceeds the allowed length or contains an
additional Bit sequence (Stopbit error)

2 | parity Parity error
3 |overflow Buffer is full
STX/ETX
Bit | Error Description
0 |overflow The received telegram exceeds the size of the receive
buffer.
1 |char A sign outside the range 20h...7Fh has been received.
3 |overflow Buffer is full

3964R / Modbus RTU/ASCII Master

Bit | Error Description
0 |overflow The received telegram exceeds the size of the receive
buffer.
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RetVal SFC 218
(Error message

Return values of the block:

SER_RCV)

Error code |Description
0000h no error
1000h Receive buffer too small (data loss)
8x24h Error at SFC-Parameter x, with x:
1: Error at "DataPtr"
2: Error at "DatalLen"
3: Error at "Error"
8122h Error in parameter "DataPtr" (e.g. DB too short)
809Ah Serial interface not found res. interface is used by
PROFIBUS
809Bh Serial interface not configured

Principles of
programming

N

RetVal 8xo¢h ?

@

The following picture shows the basic structure for programming a receive
command. This structure can be used for all protocols.

SFC 218
SER_RCV

RetVal 0000h ?

Data evaluation

Error evaluation

HB140E - CPU SC - RE_312-5BE13 - Rev. 12/12
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Protocols and procedures

Overview

ASCII

STX/ETX

The CPU supports the following protocols and procedures:
» ASCII communication

o« STX/ETX

* 3964R

+ USS

* Modbus

ASCII data communication is one of the simple forms of data exchange.
Incoming characters are transferred 1 to 1.

At ASCII, with every cycle the read-SFC is used to store the data that is in
the buffer at request time in a parameterized receive data block. If a
telegram is spread over various cycles, the data is overwritten. There is no
reception acknowledgement. The communication procedure has to be
controlled by the concerning user application. An according Receive_ASCII
FB may be found in the service area of www.vipa.de.

STX/ETX is a simple protocol with start and end ID, where STX stands for
Start of Text and ETX for End of Text.

The STX/ETX procedure is suitable for the transfer of ASCII characters. It
does not use block checks (BCC). Any data transferred from the periphery
must be preceded by a start followed by the data characters and the end
character.

Depending of the byte width the following ASCIl characters can be
transferred: 5Bit: not allowed: 6Bit: 20...3Fh, 7Bit: 20...7Fh, 8Bit: 20...FFh.
The effective data, which includes all the characters between Start and End
are transferred to the PLC when the End has been received.

When data is send from the PLC to a peripheral device, any user data is
handed to the SFC 217 (SER_SND) and is transferred with added Start-
and End-ID to the communication partner.

Message structure:

STX1 — STX2 — 21 — 22 Zn — ETX1

ETX2 —

—ZVZ<—

You may define up to 2 Start- and End-IDs.

You may work with 1, 2 or no Start- and with 1, 2 or no End-ID. As Start-
res. End-ID all Hex values from 01h to 1Fh are permissible. Characters
above 1Fh are ignored. In the user data, characters below 20h are not
allowed and may cause errors. The number of Start- and End-IDs may be
different (1 Start, 2 End res. 2 Start, 1 End or other combinations). For not
used start and end characters you have to enter FFh in the hardware
configuration. If no End-ID is defined, all read characters are transferred to
the PLC after a parameterizable character delay time (Timeout).

6-14
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3964R

The 3964R procedure controls the data transfer of a point-to-point link
between the CPU and a communication partner. The procedure adds
control characters to the message data during data transfer. These control
characters may be used by the communication partner to verify the
complete and error free receipt.

The procedure employs the following control characters:

e STX Start of Text

« DLE Data Link Escape

« ETX End of Text

- BCC Block Check Character
« NAK Negative Acknowledge

Procedure Active partner

STX

Passive partner

—>

Monitor delayed acknowledgment

44— DLE

Message-data —_—

DLE

ETX

BCC

—>
—>

—>

Monitor delayed acknowledgment

You may transfer a maximum of 255Byte per message.

Note!

When a DLE is transferred as part of the information it is repeated to
distinguish between data characters and DLE control characters that are
used to establish and to terminate the connection (DLE duplication). The
DLE duplication is reversed in the receiving station.

The 3964R procedure requires that a lower priority is assigned to the
communication partner. When communication partners issue simultaneous
send commands, the station with the lower priority will delay its send
command.
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USS

Broadcast with set
Bit 5 in ADR-Byte

The USS protocol (Universelle serielle Schnittstelle = universal serial
interface) is a serial transfer protocol defined by Siemens for the drive and
system components. This allows to build-up a serial bus connection
between a superordinated master and several slave systems.

The USS protocol enables a time cyclic telegram traffic by presetting a fix
telegram length.

The following features characterize the USS protocol:

. Multi point connection

. Master-Slave access procedure

. Single-Master-System

. Max. 32 participants

. Simple and secure telegram frame

You may connect 1 master and max. 31 slaves at the bus where the single
slaves are addressed by the master via an address sign in the telegram.
The communication happens exclusively in half-duplex operation.

After a send command, the acknowledgement telegram must be read by a
call of the SFC 218 SER_RCV.

The telegrams for send and receive have the following structure:

Master-Slave telegram

STX |LGE | ADR PKE IND PWE STW HSW | BCC

02h H]L|HJ]L[H]JL|[H]JL|[HIL

Slave-Master telegram

STX|LGE | ADR PKE IND PWE ZSW HIW BCC
02h H]L|HJ]L[H]JL|[H]JL|[HIL
where STX: Start sign STW: Control word

LGE: Telegram length ZSW: State word

ADR: Address HSW: Main set value

PKE: Parameter ID HIW: Main effective value

IND: Index BCC: Block Check Character

PWE: Parameter value

A request may be directed to a certain slave ore be sent to all slaves as
broadcast message. For the identification of a broadcast message you
have to set Bit 5 to 1 in the ADR-Byte. Here the slave addr. (Bit 0 ... 4) is
ignored. In opposite to a "normal" send command, the broadcast does not

7 6 5 4 32 10
‘ ‘ ‘ 1 ‘ ‘ ‘ ‘ ‘ ‘ require a telegram evaluation via SFC 218 SER_RCV. Only write
‘ commands may be sent as broadcast.
Broadcast
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Modbus

Broadcast with
slave address = 0

ASCIIl, RTU mode

Supported Modbus
protocols

The Modbus protocol is a communication protocol that fixes a hierarchic
structure with one master and several slaves.

Physically, Modbus works with a serial half-duplex connection.

There are no bus conflicts occurring, because the master can only
communicate with one slave at a time. After a request from the master, this
waits for a preset delay time for an answer of the slave. During the delay
time, communication with other slaves is not possible.

After a send command, the acknowledgement telegram must be read by a
call of the SFC 218 SER_RCV.

The request telegrams send by the master and the respond telegrams of a
slave have the following structure:

Start Slave Function Data Flow End
sign address |Code control |sign

A request can be directed to a special slave or at all slaves as broadcast
message. To mark a broadcast message, the slave address 0 is used.

In opposite to a "normal" send command, the broadcast does not require a
telegram evaluation via SFC 218 SER_RCV.

Only write commands may be sent as broadcast.

Modbus offers 2 different transfer modes:

» ASCIlI mode: Every Byte is transferred in the 2 sign ASCII code. The
data are marked with a start and an end sign. This causes a transparent
but slow transfer.

* RTU mode: Every Byte is transferred as one character. This enables a
higher data pass through as the ASCIlI mode. Instead of start and end
sign, a time control is used.

The mode selection happens during runtime by using the SFC 216 SER_CFG.

The following Modbus Protocols are supported by the RS485 interface:
* Modbus RTU Master
* Modbus ASCII Master
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Modbus - Function codes

Naming Modbus has some naming conventions:
convention

Bit = IN: "Input Status"
Coil OUT: "Coil Status"

Word = | IN: "Input Register"
Register | OUT: "Holding Register"

* Modbus differentiates between bit and word access;
Bits = "Coils" and Words = "Register".

» Bit inputs are referred to as "Input-Status" and Bit outputs as "Coil-
Status".

 Word inputs are referred to as "Input-Register" and Word outputs as
"Holding-Register".

Range definitions Normally the access at Modbus happens by means of the ranges 0x, 1x, 3x
and 4x.

Ox and 1x gives you access to digital Bit areas and 3x and 4x to analog
word areas.

For the CPs from VIPA is not differentiating digital and analog data, the
following assignment is valid:

Ox: Bit area for master output data
Access via function code 01h, 05h, OFh

1x: Bit area for master input data
Access via function code 02h

3x:  Word area for master input data
Access via function code 04h

4x. Word area for master output data
Access via function code 03h, 06h, 10h

1x0001

——— 1x0002 1x0022
1x0003
LIRS EEEEEEEEEE NEEEEEEEEEEEEEEE
3x0001 3x0002 3x0003
0x0001
0x0002 0x0022
0x0003
OUT [T I T I I T T
4x0001 4x0002 4x0003

A description of the function codes follows below.
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Overview

Point of View of
"Input" and
"Output" data

With the following Modbus function codes a Modbus master can access a
Modbus slave: With the following Modbus function codes a Modbus master
can access a Modbus slave. The description always takes place from the
point of view of the master:

Code |Command
01h Read n Bits
02h Read n Bits
03h Read n Words
04h Read n Words
05h Write 1 Bit
06h Write 1 Word
OFh Write n Bits
10h Write n Words

Description

Read n Bits of master output area 0x
Read n Bits of master input area 1x
Read n Words of master output area 4x
Read n Words master input area 3x
Write 1 Bit to master output area 0x
Write 1 Word to master output area 4x
Write n Bits to master output area 0x
Write n Words to master output area 4x

The description always takes place from the point of view of the master.
Here data, which were sent from master to slave, up to their target are
designated as "output" data (OUT) and contrary slave data received by the
master were designated as "input" data (IN).

System 200V - Slave Periphery
PtP ‘ CPU
System 300S - Master
CPU PtP ouT
write (05h,0F :bit, 06h10h:word) > Ox(bit) » RECEIVE FC1 ouT » ouT
ouT read (01h:bit, 03h:word) 4x(word)
IN
IN read (02h:bit, 04h:word) 1x(bit) < SEND FCO IN €—— IN
3x(wort)

Respond of the
slave

Byte sequence
in a Word

Check sum CRC,
RTU, LRC

If the slave announces an error, the function code is send back with an
"ORed" 80h. Without an error, the function code is sent back.

Function code OR 80h
Function code

= Error
- OK

Slave answer:

1 Word

High Low
Byte Byte

For the Byte sequence in a Word is always valid:

The shown check sums CRC at RTU and LRC at ASCIl mode are
automatically added to every telegram. They are not shown in the data
block.
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Read n Bits
01h, 02h

Code 01h: Read n Bits of master output area 0x
Code 02h: Read n Bits of master input area 1x

Command telegram

Slave address | Function code Address Number of Check sum
1. Bit Bits CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Respond telegram
Slave address | Function code Number of Data Data Check sum
read Bytes 1. Byte 2. Byte CRC/LRC
1Byte 1Byte 1Byte 1Byte 1Byte 1Word
max. 250 Byte
Read n Words 03h: Read n Words of master output area 4x
03h, 04h 04h: Read n Words master input area 3x
Command telegram
Slave address | Function code Address Number of Check sum
1. Bit Words CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Respond telegram
Slave address | Function code Number of Data Data Check sum
read Bytes 1. Word 2. Word CRC/LRC
1Byte 1Byte 1Byte 1Word 1Word 1Word
max. 125 Words
Write 1 Bit Code 05h: Write 1 Bit to master output area Ox
05h A status change is via "Status Bit" with following values:
"Status Bit" = 0000h - Bit=0
"Status Bit" = FFOOh - Bit =1
Command telegram
Slave address | Function code Address Status Check sum
Bit Bit CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Respond telegram
Slave address | Function code Address Status Check sum
Bit Bit CRC/LRC
1Byte 1Byte 1Word 1Word 1Word

6-20
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Write 1 Word
06h

Code 06h: Write 1 Word to master output area 4x

Command telegram

Write n Bits OFh

Command telegram

Slave address | Function code Address Value Check sum
word word CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Respond telegram
Slave address | Function code Address Value Check sum
word word CRC/LRC
1Byte 1Byte 1Word 1Word 1Word

Code OFh: Write n Bits to master output area 0x
Please regard that the number of Bits has additionally to be set in Byte.

Slave address | Function Address Number of Number of Data Data Check sum
code 1. Bit Bits Bytes 1.Byte | 2. Byte CRC/LRC
1Byte 1Byte 1Word 1Word 1Byte 1Byte 1Byte 1Byte 1Word
max. 250 Byte
Respond telegram
Slave address | Function Address Number of | Check sum
code 1. Bit Bits CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
Write n Words 10h  Code 10h: Write n Words to master output area 4x
Command telegram
Slave address | Function Address Number of Number of Data Data Check sum
code 1. Word words Bytes 1. Word | 2. Word CRC/LRC
1Byte 1Byte 1Word 1Word 1Byte 1Word 1Word 1Word 1Word
max. 125 Words
Respond telegram
Slave address | Function | Address Number of Check sum
code 1. Word Words CRC/LRC
1Byte 1Byte 1Word 1Word 1Word
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Modbus - Example communication

Outline

Components

Approach

The example establishes a communication between a master and a slave
via Modbus. The following combination options are shown:

Modbus master (M) Modbus slave (S)
CPU 31xS

CPU 21xSER-1

The following components are required for this example:

CPU 31xS as Modbus RTU master

CPU 21xSER-1 as Modbus RTU slave

Siemens SIMATIC Manager and possibilities for the project transfer
Modbus cable connection

Assemble a Modbus system consisting of a CPU 31xS as Modbus
master and a CPU 21xSER-1 as Modbus slave and Modbus cable.

Execute the project engineering of the master!
For this you create a PLC user application with the following structure:

OB 100:

OB 1:

Call SFC 216 (configuration as Modbus RTU master) with
timeout setting and error evaluation.

Call SFC 217 (SER_SND) where the data is send with error
evaluation. Here you have to build up the telegram according
to the Modbus rules.

Call SFC 218 (SER_RECV) where the data is received with
error evaluation.

Execute the project engineering of the slave!
The PLC user application at the slave has the following structure:

OB 100:

OB 1:

Call SFC 216 (configuration as Modbus RTU slave) with
timeout setting and Modbus address in the DB and error
evaluation.

Call SFC 217 (SER_SND) for data transport from the slave
CPU to the output buffer.

Call SFC 218 (SER_RECV) for the data transport from the
input buffer to the CPU. Allow an according error evaluation
for both directions.

The following page shows the structure for the according PLC programs for
master and slave.
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Master

CPU 31xS

Slave

CPU 21xSER-1
CPU

Slave ‘

— SER_RCV

L —» RetVal

<— SER_SND

CPU ‘ Master
| SER SND | code/data
|
| SERRCV < = T
]
:
\ code !
| SER_SND | '
]
| SER RCV @ —

0OB100:

SFC 216
SER_CFG
(DB: Timeout)

OB1: le

SFC 217
SER_SND

(mit Slave-Nr., Code,

Bereich)

RetVal 700xh?
N

N
N
N
o

SER_RCV

N

etVal 8xxxh -

RetVal 0000h ? >J
J
N
L

SER_SND
RetVal 2001h

N- Data evaluation

it

L —» RetVal

SFC 216

SER_CFG
(DB: Timeout, slave address)

N

SFC 217
SER_SND

N

v

RetVal 0000h ? >J—

N
L

SFC 218
SER_RCV

N

N

L

RetVal 0000h ? >J Data evaluation
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Chapter 7 WinPLC7

Overview In this chapter the programming and simulation software WinPLC7 from
VIPA is presented. WIinPLC7 is suited for every with Siemens STEP®7
programmable PLC.

Besides the system presentation and installation here the basics for using
the software is explained with a sample project.

More information concerning the usage of WinPLC7 may be found in the
online help respectively in the online documentation of WinPLC?7.

Content Topic Page
Chapter 7 WINPLCT ... 7-1

System presentation...........oo i 7-2

INSEAIALION ... 7-3

Example project engineering ............oooooiiiiiiiiiiiiii e 7-4
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System presentation

General WiInPLC7 is a programming and simulation software from VIPA for every
PLC programmable with Siemens STEP®7.
This tool allows you to create user applications in FBD, LAD and STL.
Besides of a comfortable programming environment, WinPLC7 has an

integrated simulator that enables the simulation of your user application at
the PC without additional hardware.

This “Soft-PLC” is handled like a real PLC and offers the same error
behavior and diagnosis options via diagnosis buffer, USTACK and
BSTACK.

Note!

Detailed information and programming samples may be found at the online
help respectively in the online documentation of WinPLC?7.

Alternatives There is also the possibility to use the Siemens SIMATIC manager instead
of WinPLC7 from VIPA. Here the proceeding is part of this manual.

System * Pentium with 233MHz and 64Mbyte work space
requirements « Graphics card with at least 16bit color - we recommend a screen
resolution of at least 1024x768 pixel.

» Windows 98SE/ME, Windows 2000,
Windows XP (Home and Professional), Windows Vista

Source You may receive a demo version from VIPA. Without any activation with
the demo version the CPUs 11x of the System 100V from VIPA may be
configured.

To configure the SPEED7 CPUs a license for the "profi" version is
necessary. This may be online received and activated.

There are the following sources to get WinPLC7:

Online At www.vipa.de in the service area at Downloads a link to the current demo
version and the updates of WinPLC7 may be found.

CD Order no. Description

SW211C1DD |WinPLC7 Single license, CD, with documentation in german

SW211C1ED |WinPLC?7 Single license, CD, with documentation in english

SW900TOLA | ToolDemo
VIPA software library free of charge respectively demo
versions, which may be activated
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Installation

Preconditions

Installation
WinPLC7
Demo

Activation of the
"Profi" version

Installation of
WinPCAP for
station search via
Ethernet

The project engineering of a SPEED7 CPU from VIPA with WinPLC7 is
only possible using an activated "Profi" version of WinPLC7.

The installation and the registration of WinPLC7 has the following
approach:

For installation of WinPLC7 start the setup program of the
corresponding CD respectively execute the online received exe file.

Choose the according language.
Agree to the software license contract.

Set an installation directory and a group assignment and start the
installation.

Start WinPLC7. A "Demo" dialog is shown.
Click at [Activate Software]. The following dialog for activation is shown:

Serial number (34-digit] |

System number: SYS-1969PLCTVE.

Activating key:

Get activation key orline [via intemet]

Install dive=C\PROGRAMME WMHJ-SOF TWAREVWINSPS-S 745,

Fill in the following fields:
Email-Addr., Your Name und Serial number. The serial number may be
found on a label at the CD case.

If your computer is connected to Internet you may online request the
Activation Key by [Get activation key via Internet]. Otherwise click at
[This PC has no access to the internet] and follow the instructions.

With successful registration the activation key is listed in the dialog
window respectively is sent by email.

Enter the activation key and click to [OK]. Now, WinPLC?7 is activated as
"Profi" version.

To find a station via Ethernet (accessible nodes) you have to install the
WiInPCAP driver. This driver may be found on your PC in the installation
directory at WinSPS-S7-V5/WinPcap_... .exe.

Execute this file and follow the instructions.
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Example project engineering

Job definition In the example a FC 1 is programmed, which is cyclically called by the
OB 1. By setting of 2 comparison values (valuel and value2) during the FC
call, an output of the PLC-System should be activated depending on the
comparison result.

Here it should if valuel = value2 activate output Q 124.0
apply: if valuel > value2 activate output Q 124.1
if valuel < value2 activate output Q 124.2

Precondition * You have administrator rights for your PC.
« WinPLCY7 is installed and activated as "Profi" version.
* Your SPEED7 CPU is installed and cabled.

» The Ethernet PG/OP channel of the CPU is connected to your Ethernet
network. Your CPU may be connected to your PC with an Ethernet
cable either directly or via hub/switch.

» WinPCap for station search via Ethernet is installed.
» The power supply of the CPU is activated and the CPU is in STOP

state.
Project o Start WinPLC7 ("Profi" version)
engineering e Create and open a new project with [Create a new solution].
Hardware » For the call of the hardware configurator it is necessary to set WinPLC7
configuration from the Simulator-Mode to the Offline-Mode. For this and the communi-

cation via Ethernet set "Target: TCP/IP Direct".

File Edt Block PLC View Extras Help

all blocks inta the PLC  Reset filts

Dbject s ame g2t :
ars
Docunertaton g 0m o1 10 STLFEDLAD nb 2 08 nb b 2011

» Double click to "Hardware stations" and here at "Create new".

S7-PROG-22072011-164430-ENG 5]
i Blocks
@ syl

“m
20
s % m]
] PLCOrﬁfm:nEw\ % o
« Enter a station name. Please consider that the name does not contain
any spaces.

» After the load animation choose in the register Select PLC-System the
system "VIPA SPEED7" and click to [Create]. A new station is created.

» Save the empty station.

» By double click or drag&drop the according VIPA CPU in the hardware
catalog at CPU SPEED7 the CPU is inserted to your configuration.

» Assign, if not automatically happened, the output area of the CPU-SC to
the start address 124 and save the hardware configuration.
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Online access via
Ethernet PG/OP
channel

Transfer hardware
configuration

Open the CPU-Properties, by double clicking to the CPU at slot 2 in the
hardware configurator.

Click to the button [Ethernet CP-Properties (PG/OP-channel)]. The
Properties CP343 is opened.

Chose the register Common Options.
Click to [Properties Ethernet].
Choose the subnet "PG_OP_Ethernet".

Enter a valid IP address-and a subnet mask. You may get this from your
system administrator.

Close every dialog window with [OK].
Select, if not already done, "Target: External TCP/IP direct".

Open with Online > Send configuration to the CPU a dialog with the
same name.

Click to [Accessible nodes]. Please regard to use this function it is
necessary to install WinPCap before!

Choose your network card and click to [Determining accessible nodes].
After a waiting time every accessible station is listed. Here your CPU
with IP 0.0.0.0 is listed, too. To check this the according MAC address is
also listed. This MAC address may be found at a label beneath the front
flap of the CPU.

For the temporary setting of an IP address select you CPU and click to
[Temporary setting of the IP parameters]. Please enter the same IP
parameters, you configured in the CPU properties and click to [Write
Parameters].

Confirm the message concerning the overall reset of the CPU. The IP
parameters are transferred to the CPU and the list of accessible stations
is refreshed.

Select you CPU and click to [Confirm]. Now you are back in the dialog
"Send configuration".

Choose your network card and click to [Send configuration]. After a
short time a message is displayed concerning the transfer of the
configuration is finished.

Note!

Usually the online transfer of the hardware configuration happens within
the hardware configurator.

With File > Save active station in the WIinPL7 sub project there is also the
possibility to store the hardware configuration as a system file in WinPLC7
to transfer it from WinPLC7 to the CPU.

The hardware configuration is finished, now and the CPU may always be
accessed by the IP parameters as well by means of WinPLC?7.
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Programming of The PLC programming happens by WinPLC7. Close the hardware
the FC 1 configurator and return to your project in WinPLC7.

The PLC program is to be created in the FC 1.

Creating block FC 1« In "Project content" choose New > FC.
;::&Wﬂ;d;}* QF;MiW-;ii-i e | e T RS B 10
: —

Edit project I ot conten:

W sreno6-ze0720L1- 1084305 50D

» Enter "FC1" as block and confirm with [OK]. The editor for FC 1 is

called.
Creating In the upper part of the editor there is the parameter table. In this example
parameters the 2 integer values valuel und value2 are to be compared together. Since

both values are read only by the function, these are to be defined as "in".

o Select the "in -->" row at the parameter table and enter at the field
Name "value1". Press the [Return] key. The cursor jumps to the column
with the data type.

» The data type may either directly be entered or be selected from a list of
available data types by pressing the [Return] key. Set the data type to
INT and press the [Return] key. Now the cursor jumps to the Comment
column.

» Here enter "1. compare value" and press the [Return] key. A new "in -->"
row is created and the cursor jumps to Name.

* Proceed for value2 in the same way as described for valuel.

» Save the block. A note that the interface of the block was changed may
be acknowledged with [Yes].

The parameter table shows the following entries, now:
-+ |

b= H @ @ dh ‘B = =8 Load FCl into the PLC C Synchronize 9" Monitaring Onjoff Metwark 1

= Address  Declaration MName Type Initial value Comment
0.0 _ waluel INT 1. compare value

20 _ value? INT 2. compare value

out <

4
&
L
o
o
ju)
=
[0
&
b

in_out =5
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Enter the program As requested in the job definition, the corresponding output is activated
depending on the comparison of valuel and value2. For each comparison
operation a separate network is to be created.

» The program is to be created as FBD (function block diagram). Here

change to the FBD view by clicking at FBD.

LAD 3y [Fetwork 1 ¥ Network ticle=

Network comment=

<emptys

Click to the input field designated as "<empty>".

The available operations may be added to your project by drag&drop
from the hardware catalog or by double click at them in the hardware

catalog.

* Open in the catalog the category "Comparator" and add the operation

"CMP==I" to your network.

File Edit Black PLC Wiew Extras Help
BN dnlm®d S E-A-EEEAE -8 x5 GG s F T T Taget Sinulator
JEoocn. g ]
[~} =
% 2-[>] Comparatar I A gy T oL =[] B @ = -6 leadFotinto the PLC £ Synchronize 6
= 3] CMP == ol == - Addess Declarstion  Mame Type Iritial ve
3 »] CHP ol 8 0.0 valuel INT
3 »] EMPol o 20 value2 INT
C oz >] CHP <l & ot .
i gl CMP > & in_out <>
o >] CMP <=l g i =
»] CMP ==D T
i 3] CMP <D $ =Title of FC=»
"%: 7] EMPD o Block comment=
g »] CHP<D N
] >] CMP>=D o
£ 3] CMP <=D 8
= 5] CMP =R & STL LAD (8 |Network 1 ¥ Wetwork titles
& >] CMP oR G|y T
57 >] CHP >R . e e
>] CMP <R s
2 = I | O CUUTooiiniiiiiiiiiiiiiiiiiiiiiioiiin
e >] CMP <=R DIl (INT) BRIl
B | o L Converer
|| = (1] Counter Vllirre oy = A S S S S S S

i o] DE-Cal

» Click to the input left above and

B 50 e [

insert valuel. Since these are block

parameters a selection list of block parameters may be viewed by

entering "#".

» Type in "#" and press the [Return] key.
» Choose the corresponding parameter and confirm it with the [Return]

key.

* Proceed in the same way with the parameter value2.
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Adding a new
network

The allocation to the corresponding output, here Q 124.0, takes place with
the following proceeding:

» Click to the output at the right side of the operator.

» Open in the catalog the category "Bit logic" and select the function
"--[=]". The inserting of "--=" corresponds to the WinPLC7 shortcut [F7].

* Insert the output Q 124.0 by clicking to the operand.

Network1 is finished, now.

For further comparisons the operations "CMP>|" at Q 124.1 and "CMP<I"
at Q 124.2 are necessary. Create a network for both operations with the
following proceeding:

« Move your mouse at an arbitrary position on the editor window and
press the right mouse key.

» Select at the context menu "Insert new network". A dialog field is
opened to enter the position and number of the networks. Or click at
[Add a network at the end of the block].

* Proceed as described for "Network 1".

» Save the FC 1 with File > Save content of focused window respectively
press [Strg]+[S].

7-8
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FC1 After you have programmed the still missing networks, the FC 1 has the
following structure:

m=  s7i  [FED] i By By B D

Network comment=

CHMP

#raluel — T2

0lz4._0
Hralue s —— .

w=  z7n [FED] i By By B D

Network comment=

CHMP

fraluel — =T

0lz4.1
fralue? —— e

m= oL [FED] i By By B D

Network comments=

CHF

firalugl — <I

nlz4._ z
BralUe? e . g
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Creating the block  The FC 1 is to be called from the cycle OB 1.
OB 1 » Go to OB1, which was automatically created with starting the project.
» Go to "Project content" or to "Solution" and open the OB1 by a double
click.
» Change to the STL view.

» Type in "Call FC 1" and press the [Return] key. The FC parameters are
automatically displayed and the following parameters are assigned:

"Cyclic main program"

Block comments

== [3TI] FED  LAD 3 |Network 1 X He

Network comment=

o CALL FC 1
1 wvaluel:=10-

z wvaluez :=10-

3

» Save the OB 1 with H or [Strg]+[S].

Test the PLC With WinPLC?7 there is the possibility to test your project in a simulator.
program in the * Here select "Target: Simulator".
Slmulator File Edt Block PLC Wiew Extras Help

EanttdJnmm S H-F-0H&FE 8 x Target: Simulator
. Editproject 2 I poect content Targel Sinulator
et c [PROG-22072011-164430-ENG.WST {5olut X A
‘:g\; £ |57-PROG-22072011-164430-ENG L3z Open "’_‘, Mew... Refresh *I Load selected blocks into the PLC | Target: TCP/IP-Direct all blacks into the PLC
= Il Blocks i Target: MHJ-HetLink T3
T =<} OB b Taiget NETLink PRO TCR i
i * create new B | | [t [Vension Symboionane | InIERRNN(WY Al hemary |DI7| Rae |
I ‘W 0BL g O oe1 10 STLFBDLAD nb 2 108 b
e | = s 2040 o 10 STLFEDALAD mh 16 106 b
N | e & 0@  svMBOLTABLE SEQ Symbolic tatle
» Transfer the blocks to th

e simulator with [Load all blocks into the PLC].
[E 2 N P B ok B

+::Project content

Target: Simulator

il open ¥ Mew... Refresh [ Load selected blocks into the PLC {0 Synchronize CTRLHI ¥ Load all blocks into the PLC Resst filter

O E (=3} STLFED-LAD nb 40 146 - onl nb 2011-7-25113:24:45(56) 2011-7-25 1 13:24:45(56)
O Tt FC1 STLFBD-LAD  mh 16 106 - nb nb 2011-7-22 |1 17:49:29(32) 2011-7-22 118:16:55(92)
O SYMBOLTABLE.SEQ Symbolic table
[ & WARIABLETABELLE VAR Status-Variable

» Switch the CPU to RUN, by clicking at RUN in the "CPU Control Center"
of "Edit project". The displayed state changes from STOP to RUN.

» To view the process image select View > Display process image
window or click at '=*=f. The various areas are displayed.

* Double click to the process image and enter at "Line 2" the address
PQB124. Confirm with [OK]. A value marked by red color corresponds to
a logical "1".

* Openthe OB 1.

» Change the value of one variable, save the OB 1 and transfer it to the
simulator. According to your settings the process image changes
immediately. The status of your blocks may be displayed with Block >
Monitoring On/Off.
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Visualization via A further component of the simulator is the PLC mask. Here a CPU is
PLC mask graphically displayed, which may be expanded by digital and analog
peripheral modules.

As soon as the CPU of the simulator is switched to RUN state, inputs may
be activated by mouse and outputs may be displayed.

Transfer PLC .
program to CPU
and its execution .

Open the PLC mask with view > PLC mask. A CPU is graphically
displayed.

Double-click to the output module, open its properties dialog and enter
the Module address 124.

Switch the operating mode switch to RUN by means of the mouse. Your
program is executed and displayed in the simulator, now.

AL e AP

e = wi T
EARAAARS S oA EE M0 = PR T e e 1=
Edmmt S R B

A o
s . =i
l ==t
' -1 0
el 'l
F
ac
x
. i E mea

For transfer to the CPU set the transfer mode to "Target: TCP/IP-
Direct".

If there are more network adapters in your PC, the network adapter may
be selected via Extras > Select network adapter.

For presetting the Ethernet data click to [...] and click to
[Accessible nodes].

O oet STLFEDLAD  nb 40 146 - rb 201-7-25 | 13:24:45(56)  2011-7-2511%
(o] A ——— STLFBDLAD mh 16 106 - nb nb 2172201743293 201172201
[]<@  S5YMBOLTABLE.SEQ Symbolic table

430-ENGPR] 3 [

Click at [Determining accessible nodes]. After a waiting time every
accessible station is listed.

Choose your CPU, which was provided with TCP/IP address parameters
during the hardware configuration and click to [Confirm].

Close the "Ethernet properties" dialog with [OK].

Transfer your project to your CPU with PLC > Send all blocks.
Switch your CPU to RUN state.

Open the OB 1 by double click.

Change the value of one variable, save the OB 1 and transfer it to the
CPU. According to your settings the process image changes imme-
diately. The status of your blocks may be displayed with Block >
Monitoring On/Off.
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